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1 Description 

Server Board Features 
The SE7500WV2 is available in either SCSI or ATA hard drive interface versions as described in 
Table 1.  The features listed in Table 2 are common to both server board versions. 

Table 1. Server Board Versions 
Feature Description 

SCSI Dual channel Ultra160 LVD SCSI accessible at rear panel I/O and internally 

ATA Dual channel ATA 100 RAID 

✏ NOTE 

The feature set listed in Table 2 only reflects usage with either the 1U  
Intel® SR1300 or the 2U Intel® SR2300 server chassis.  Third-party or OEM 
chassis may not provide all of the features listed below. 

Table 2. Server Board Features 
Feature Description 

Processors Dual processor slots supporting Intel® Xeon™ processors in an INT3/FCPGA Socket 
604 package. 

Memory Six dual inline memory module (DIMM) slots support: 

• DDR-200 or DDR-266 compliant, ECC, registered, 72-bit, 168-pin, DIMMs 

• From 256MB to 12 GB of memory 

Graphics Integrated onboard ATI RAGE† XL PCI SVGA controller. 

Video Memory 8 MB SDRAM of video memory. 

PCI bus Two PCI riser slots capable of supporting either of the following configurations: 

• 1U configuration-one full-length, full-height 64-bit PCI riser slot and one Low Profile 
(LP) 64-bit PCI riser slot. 

• 2U configuration-three full-length, full-height 64-bit PCI riser slots and three LP 64-bit 
PCI riser slots. 

Network Dual on-board 10/100/1000 Network Interface Controllers (NIC). 

System I/O 

(See Table 1) 

One PS/2† keyboard/mouse port (6 pin DIN). 

One VGA video port (15 pin). 

Two external USB ports, internal header providing two additional USB. 

One external serial port (RJ-45), one internal COM 1 header. 

One external SCSI port (SCSI server board only), one internal. 

Two NIC ports (RJ-45). 

Form Factor Server ATX form factor. 
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Server Board Connector and Component Locations 
The SE7500WV2 comes in both SCSI and ATA versions. Figure 1 is a composite view of both 
versions. 
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A. System status LED P. Auxiliary signal connector 
B. ID LED Q. Sys fan 1 connector 
C. Diagnostic LEDs (POST code) R. Sys fan 2 connector 
D. 64-bit PCI riser slot for PCI-X bus B (full height) S. Main power connector 
E. DIMM slots T. Battery 
F. I/O ports U. Power supply signal connector 
G. SCSI channel B connector (SCSI version only) V. ATX front panel connector 
H. COM 1 serial header W. SSI front panel connector 
I. ICMB connector X. Floppy/FP/IDE connector 
J. IPMB connector Y. ATA/IDE connector 
K. 64-bit PCI riser slot for PCI-X bus C (low profile) Z. Floppy drive connector 
L. Secondary processor socket AA. USB 2 & 3 header 
M. Secondary processor fan connector BB. ATA-100 connectors (ATA version only) 
N. Primary processor socket CC. Hard Disk Drive LED header 
O. Primary processor fan connector  DD. Speaker 

Figure 1.  Server Board Connector and Component Locations 
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Back Panel Connectors 
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A. USB 0 connector 
B. Video connector 
C. SCSI channel A connector (SCSI server board only) 
D. NIC 2 RJ-45 connector 
E. Status LED  
F. Speed LED 
G. NIC 1 RJ-45 connector 
H. Status LED 
I. Speed LED 
J. PS/2 keyboard/mouse connector 
K. RJ-45 serial port 
L. USB 1 connector 

Figure 2.  Back Panel Connectors 
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Processor 
The SE7500WV2 accommodates one or two Intel Xeon processors with 512k cache in the 
INT3/FCPGA Socket 604 package.  This processor uses the .13 micron technology.  Check the 
Intel Customer Support website for the latest list of supported processors see: 

http://support.intel.com/ 

Memory 
The system board has six 168-pin DIMM slots each supporting 72-bit ECC registered DDR 
DIMMs (DDR-200 or DDR-266 compatible).  Memory is partitioned in three banks.  You may 
install a minimum of 256 MB (128MB x 2) and as much as 12 GB.  Memory must be installed in 
pairs, starting with bank 1 (slots 1B and 1A). 

The controller automatically detects, sizes, and initializes the memory array, depending on the type, 
size, and speed of the installed DIMMs, and reports memory size and allocation to the server via 
configuration registers. 

✏ NOTE 

Use DIMMs that have been tested for compatibility with the server board.  
Contact your sales representative or dealer for a current list of approved 
memory modules.  Check the Intel Customer Support website for the latest 
tested memory list. 

http://support.intel.com/ 

PCI Riser Slots 
The server board has two PCI riser slots.  Riser slot B provides the following features: 

• 184 pin, 5 volt keyed, 64-bit expansion slot connector 
• Support for either a 1-slot or a 3-slot PCI riser card 
• Support for both full length and low profile PCI cards 

Riser C provides the following features: 

• 184 pin, 5 volt keyed, 64-bit expansion slot connector 
• Support for either a 1-slot or a 3-slot PCI riser card 
• Support for only low profile PCI cards 

Video 
The SE7500WV2 uses an ATI RAGE XL PCI graphics accelerator with 8 MB of video SDRAM.  
The embedded SVGA video subsystem supports: 

• Resolutions up to 1600 x 1200 under 2D and 1024 x 768 under 3D 
• CRT and LCD monitors up to 100 Hz vertical refresh rate 

The server board supports disabling of the onboard video through the BIOS setup menu or when a 
plug in video card is installed in any of the PCI slots. 
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SCSI Controller 
The SCSI version of the server board includes an embedded Adaptec† AIC-7899W controller 
providing dual Ultra160 Low Voltage Differential (LVD) SCSI channels. 

The SCSI bus is terminated on the server board with active terminators that cannot be disabled.  
The onboard device must always be at one end of the bus.  The device at the other end of the cable 
must also be terminated.  LVD devices generally do not have termination built-in and need to have 
a termination source provided.  Non-LVDs devices generally are terminated through a jumper or 
resistor pack on the device itself. 

ATA-100 Controller 
The ATA version of the server board provides an embedded dual channel ATA-100 bus through the 
use of the Promise Technology† PDC20277  ATA-100 controller.  The controller contains two 
independent ATA-100 channels that share a single 32-bit, 33-MHz PCI bus master interface as a 
multifunction device.  The controller supports: 

• DMA and PIO IDE drives and ATAPI devices 
• ATA and ATAPI proposal PIO Mode 0, 1, 2, 3, 4; DMA Mode 0, 1, 2; and Ultra DMA Mode 

0, 1, 2, 3, 4, 5 
• IDE transfer rates up to 100 MB/sec per channel 
• Host interface complies with PCI Local Bus Specification Revision 2.2 

IDE RAID 
The ATA-100 controller supports IDE RAID through both ATA-100 channels.  In a RAID 
configuration, multiple IDE hard drives are placed into one or more arrays of disks.  Each array is 
seen as an independent disk, though the array may include one, two, three, or four drives.  The IDE 
RAID can be configured as follows: 

• RAID 0:  Striping one to four drives 
• RAID 1:  Mirroring two drives 
• RAID 1 +:  Spare drive (three drives) 
• RAID 0 +:  One to four drives are required 

RAID 0 configurations are used for high performance applications, as it doubles the sustained 
transfer rate of its drives.  RAID 1 configurations are primarily used for data protection.  It creates 
an identical drive backup to a secondary drive.  Whenever a disk write is performed, the controller 
sends data simultaneously to a second drive located on a different data channel.  With 4 drives 
attached to dual ATA-100 channels, two striped drive pairs can mirror each other (RAID 0+1) for 
storage capacity and data redundancy. 
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Network Controller 

✏ NOTE 

To ensure EMC product regulation compliance, the system must be used 
with a shielded LAN cable. 

The server board uses the Intel® 82546EB Fast Ethernet† Controller and supports two 
10Base-T/1000Base-TX network subsystems. 

The 82546EB controller supports the following features: 

• 32-bit PCI master interface  
• Integrated IEEE 802.3 10Base-T, 100Base-TX and 1000Base-TX compatible PHY† 
• IEEE 820.3u auto-negotiation support 
• Full duplex support at 10 Mbps, 100 Mbps, and 1000 Mbps operation 
• Low power +3.3 V device 

On the SE7500WV2, NIC 1 can be used as both a network interface and server management 
interface. 

NIC Connector and Status LEDs 
The 82546 controller drives LEDs on the network interface connector that indicate link/activity on 
the LAN and speed of operation.  The green LED indicates network connection when on and 
TX/RX activity when blinking.  The speed LED indicates 1000 Mbps when amber, 100 Mbps when 
green, and 10 Mbps when off. 

Keyboard and Mouse 
The keyboard/mouse controller is PS/2-compatible.  If specified through the System Setup Utility 
(SSU), the server may be locked automatically if there is no keyboard or mouse activity for a 
predefined length of time.  Once the inactivity (lockout) timer has expired, the keyboard and mouse 
do not respond until the previously stored password is entered.  A Y-cable can be used if both a 
PS/2 mouse and keyboard are required at the same time. 

RJ-45 Serial Port 
The rear RJ-45 serial port is a fully functional serial port that supports any standard serial device 
and provides support for serial concentrators.  For server applications that use a serial concentrator 
to access the server management features of the baseboard, a standard 8-pin CAT-5 cable from the 
serial concentrator is plugged directly into the rear RJ-45 serial port.  The 8 pins of the RJ-45 
connector can be configured to match either of two pin-out standards used by serial port devices.  
To accommodate either standard, the J5A2 jumper block located directly behind the rear RJ-45 
serial port must be jumpered appropriately according to the desired standard. 
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✏ NOTE 

By default, the RJ-45 serial port is configured to support a DSR signal. 

For serial devices that require a DSR signal (default), the J5A2 jumper must be configured in 
position 3-4 (Figure 3, B). 

For serial devices that require a DCD signal, the jumper must be in position 1-2 (Figure 3, A). 
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Figure 3.  J5A2 Jumper Block for DSR Signal 

For server applications that require a DB9 serial connector, you must use an 8-pin  
RJ-45-to-DB9 adapter.  The following table defines the pin-out required for the adapters to provide 
RS232 support. 

Table 3. Rear Serial 2 Port Adapter Pin-out 
RJ-45 Signal  Abbreviation DB9 

1 Request to Send RTS 7 

2 Data Terminal Ready DTR 4 

3 Transmitted Data TD 3 

4 Signal Ground SGND 5 

5 Ring Indicator RI 9 

6 Received Data RD 2 

7 DCD or DSR DCD/DSR 1 or 6 

8 Clear To Send CTS 8 
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ACPI 
The SE7500WV2 supports the Advanced Configuration and Power Interface (ACPI) as defined by 
the ACPI 2.0 specification.  An ACPI aware operating system can put the system into a state where 
the hard drives spin down, the system fans stop, and all processing is halted.  However, the power 
supply will still be on and the processors will still be dissipating some power, so the power supply 
fans will still run. 

The SE7500WV2 supports sleep states s0, s1, s4, and s5: 

• s0:  Normal running state. 
• s1:  Processor sleep state.  No context will be lost in this state and the processor caches will 

maintain coherency. 
• s4:  Hibernate or Save to Disk:  The memory and machine state are saved to disk.  Pressing the 

power button or other wakeup event will restore the system state from the disk and resume 
normal operation.  This assumes that no hardware changes have been made to the system while 
it was off. 

• s5:  Soft off:  Only the RTC section of the CSB and the BMC are running in this state.  No 
context is saved by the OS or hardware. 

 CAUTION 
The system is off only when the AC power cord is disconnected. 

System Management 
Intel integrates system management features into the hardware and provides additional features 
through Intel® Server Management software.  This section describes the integrated hardware 
features, Intel Server Management software, and the System Setup Utility and FRU/SDR Load 
Utility used to configure the hardware features. 

Baseboard Management Controller 
Intel server boards incorporate a baseboard management controller (BMC), which is a dedicated 
microcontroller for system management activities.  The BMC performs the following functions: 

• Monitors system components and sensors, including processors, memory, fans, power supplies, 
temperature sensors, and chassis intrusion sensors.   

• Manages nonvolatile storage for the system event log (SEL), sensor data records (SDRs), and 
baseboard field-replaceable unit (FRU) inventory. 

• Interfaces with the emergency management port (EMP) and LAN1 port to send alerts and 
interact with remote management systems. 

• Provides the main front panel control functions (power on/off, reset, and so on). 
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Field Replaceable Units and Sensor Data Records 
Field replaceable units (FRUs) are major modules in the chassis that contain active electronic 
circuitry.  FRUs can store information-such as board serial number, part number, name, and asset 
tag-that can be read using the System Setup Utility (page 49).  The BMC stores FRU information 
for the baseboard in a nonvolatile storage component on the board. 

The BMC uses Sensor Data Records (SDRs) to identify the sensors in the system for monitoring.  
SDRs provide a list of the sensors, their characteristics, location, type, and type-specific 
information, such as default threshold values, factors for converting a sensor reading into the 
appropriate units (mV, rpm, degrees Celsius), and information on the types of events that a sensor 
can generate.  The BMC stores SDR information in a nonvolatile storage component on the 
baseboard. 

You can use the FRU/SDR Load Utility (page 57) to initialize or update the FRU and SDR 
information.  Intel server boards are shipped from the factory with some sensors disabled, because 
the actual configuration of the chassis is only determined when the user completes the system 
configuration.  Chassis-specific information in the FRU, such as chassis part number, is also absent.  
For these reasons, it is important to run the FRU/SDR Load Utility as part of the system setup 
process.  You should also run the FRU/SDR Load Utility whenever you change the number of fans, 
processors, or power supplies in the server. 

System Event Log 
The BMC manages a system event log (SEL), where it records significant or critical system events.  
Such events include temperatures and voltages out of range, fan failures, and other sensor-related 
events.  The BIOS, software, and other devices can also log events by sending messages to the 
BMC.  The SEL is stored in nonvolatile storage. 

You can view the current contents of the SEL by using the System Setup Utility (page 48). 

Platform Event Management 
Events can trigger alerts and other actions by the BMC.  The server is configured with the 
following set of standard events: 

• Temperature sensor out of range 
• Voltage sensor out of range 
• Fan failure 
• Chassis intrusion 
• Power supply fault 
• BIOS uncorrectable ECC error 
• BIOS POST error 
• Processor fault resilient booting (FRB) failure 
• Fatal nonmaskable interrupt (NMI) from a source other than the front panel switch 
• Watchdog timer reset, power down, or power cycle 
• System restart (reboot) 
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Alerts can take either of these forms: 

• Platform event pages -- the BMC dials a paging service and sends a predefined paging string.  
To use platform event paging (PEP), you must attach an external modem to the emergency 
management port (Serial 2). 

• BMC LAN alerts -- the BMC sends an alert to a predefined destination on the LAN. 

You can configure PEP and BMC LAN alerts by using the System Setup Utility (page 51). 

Emergency Management Port 
The emergency management port (EMP) refers to the use of the Serial 2 port, with either an 
external modem or direct serial connection, for remote management.  The BMC controls the port 
and interfaces with remote access software, such as the Direct Platform Control application in Intel 
Server Management.   

You can configure the EMP by using the System Setup Utility (SSU) or the System Configuration 
Wizard (SCW). 

EMP and Serial Over LAN 
The RJ-45 Serial 2 port on the back panel can be configured in several different ways:  as a 
standard serial port, as an Emergency Management Port, or for serial output redirection over a 
LAN.  You can configure these settings using either the SSU or the SCW.   

✏ NOTES 

Important Intel SR1300 Server Chassis considerations:  If you have 
configured the Serial 2 port for use as an Emergency Management Port and 
“always available”, the Serial 2 port will be accessible only by remote server 
management software.  The operating system will never be able to access the 
port. 

If you have configured the Serial 2 port for Serial Over LAN, the port’s 
functionality will only be impacted when there is an active Serial Over LAN 
session from a remote console.  At all other times either the operating system 
or EMP will control the port, depending on your configuration. 

Intel® Server Management 
Intel Server Management (ISM) is a system management package that is included on the ISM CD.  
ISM applications interact with the integrated hardware system management features of the server to 
allow you to monitor and manage a server from a remote workstation: 

• Remote connection from a Windows†-based client workstation over a LAN, or over a modem 
or direct serial connection to the emergency management port on the server. 

• Real-time monitoring and alerting for server hardware sensors. 
• Emergency management when the server is off (but still connected to AC power) lets you 

verify the state of the server, diagnose hardware problems, and power on/off or reset the server.   
• Run the System Setup Utility to change the server configuration. 
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ISM can use an optional service partition on the server that you are managing.  The service partition 
is a special disk partition on the system drive that contains a ROM-DOS† operating system and  

DOS-based utilities, including the System Setup Utility, FRU/SDR Load Utility, and Remote 
Diagnostics.  The server can be booted to the service partition, either locally or remotely, to provide 
access to the utilities. 

For more information on Intel Server Management and the individual ISM applications, see the 
ISM CD. 

Security 

Intrusion Switch Monitoring 
To help prevent unauthorized entry or use of the server, Intel Server Management server 
management software monitors the chassis intrusion switch if one is installed.  Opening an access 
cover will transmit an alarm signal to the server board, where BMC firmware and server 
management software process the signal.  The system can be configured through ISM to respond to 
an intrusion a number of ways, including powering down or locking the keyboard. 

Software Locks 
The BIOS Setup and the System Setup Utility (SSU) provide a number of security features to 
prevent unauthorized or accidental access to the system.  Once the security measures are enabled, 
you can access the system only after you enter the correct password(s).  For example: 

• Enable the keyboard lockout timer so that the server requires a password to reactivate the 
keyboard and mouse after a specified time out period¾1 to 120 minutes. 

• Set and enable a supervisor password. 
• Set and enable a user password. 
• Set secure mode to prevent keyboard or mouse input and to prevent use of the front panel reset 

and power switches. 
• Activate a hot key combination to enter secure mode quickly. 
• Disable writing to the diskette drive when secure mode is set. 
• Disable access to the boot sector of the operating system hard disk drive. 

Using Passwords 
You can set either the user password, the supervisor password, or both passwords.  If only the user 
password is set, you: 

• Must enter the user password to enter BIOS Setup or the SSU. 
• Must enter the user password to boot the server if Password on Boot is enabled in either the 

BIOS Setup or SSU. 
• Must enter the user password to exit secure mode. 
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If only the supervisor password is set, you: 

• Must enter the supervisor password to enter BIOS Setup or the SSU. 
• Must enter the supervisor password to boot the server if Password on Boot is enabled in either 

the BIOS Setup or SSU. 
• Must enter the supervisor password to exit secure mode. 

If both passwords are set, you: 

• May enter the user password to enter BIOS Setup or the SSU.  However, you will not be able to 
change many of the options. 

• Must enter the supervisor password if you want to enter BIOS Setup or the SSU and have 
access to all of the options. 

• May enter either password to boot the server if Password on Boot is enabled in either the BIOS 
Setup or SSU. 

• May enter either password to exit secure mode. 

Secure Mode 
Configure and enable the secure boot mode by using the SSU.  When secure mode is in effect: 

• You can boot the server and the operating system will run, but you must enter the user 
password to use the keyboard or mouse. 

• You cannot turn off system power or reset the server from the front panel switches. 

Secure mode has no effect on functions enabled via remote server management or power control 
via the watchdog timer. 

Taking the server out of secure mode does not change the state of system power.  That is, if you 
press and release the power switch while secure mode is in effect, the system will not be powered 
off when secure mode is later removed.  However, if the front panel power switch remains 
depressed when secure mode is removed, the server will be powered off. 
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Summary of Software Security Features 
The table below lists the software security features and describes what protection each offers.  In 
general, to enable or set the features listed here, you must run the SSU and go to the Security 
Subsystem Group, menu.  The table also refers to other SSU menus and to the Setup utility. 

Table 4. Software Security Features 
Feature Description 

Secure mode How to enter secure mode: 

• Setting and enabling passwords automatically places the system in secure 
mode. 

• If you set a hot-key combination (through Setup), you can secure the system 
simply by pressing the key combination.  This means you do not have to wait 
for the inactivity time-out period. 

When the system is in secure mode: 

• The server can boot and run the operating system, but mouse and keyboard 
input is not accepted until the user password is entered. 

• At boot time, if a CD is detected in the CD-ROM drive or a diskette in drive A, 
the system prompts for a password.  When the password is entered, the 
server boots from CD or diskette and disables the secure mode. 

• If there is no CD in the CD-ROM drive or diskette in drive A, the server boots 
from drive C and automatically goes into secure mode.  All enabled secure 
mode features go into effect at boot time. 

To leave secure mode:  Enter the correct password(s). 

Disable writing to 
diskette 

In secure mode, the server will not boot from or write to a diskette unless a 
password is entered. 

To write protect access to diskette whether the server is in secure mode or not, 
use the Setup main menu, Floppy Options, and specify Floppy Access as read 
only. 

Set a time out period so 
that keyboard and 
mouse input are not 
accepted 

Also, screen can be 
blanked, and writes to 
diskette can be inhibited 

Specify and enable an inactivity time out period of from 1 to 120 minutes. 

If no keyboard or mouse action occurs for the specified period, attempted 
keyboard and mouse input will not be accepted. 

The monitor display will go blank, and the diskette drive will be write protected (if 
these security features are enabled through Setup). 

To resume activity:  Enter the correct password(s). 

Control access to using 
the SSU:  set supervisor 
password 

To control access to setting or changing the system configuration, set a 
supervisor password and enable it through Setup. 

If both the supervisor and user passwords are enabled, either can be used to 
boot the server or enable the keyboard and/or mouse, but only the supervisor 
password will allow Setup to be changed. 

To disable a password, change it to a blank entry or press CTRL-D in the 
Change Password menu of the Supervisor Password Option menu found in the 
Security Subsystem Group. 

To clear the password if you cannot access Setup, change the Clear Password 
jumper (see Chapter 6). 

continued 
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Table 4. Software Security Features (continued) 
Feature Description 

Control access to the 
system other than SSU:  
set user password 

To control access to using the system, set a user password and enable it 
through Setup. 

To disable a password, change it to a blank entry or press CTRL-D in the 
Change Password menu of the User Password Option menu found in the 
Security Subsystem Group. 

To clear the password if you cannot access Setup, change the Clear Password 
jumper (see Chapter 6). 

Boot without keyboard The system can boot with or without a keyboard.  During POST, before the 
system completes the boot sequence, the BIOS automatically detects and tests 
the keyboard if it is present and displays a message. 

Specify the boot 
sequence 

The sequence that you specify in setup will determine the boot order.  If secure 
mode is enabled (a user password is set), then you will be prompted for a 
password before the server fully boots.  If secure mode is enabled and the 
“Secure Boot Mode” option is also enabled, the server will fully boot but will 
require a password before accepting any keyboard or mouse input. 
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2 Installation Procedures 

Rearrange the Standoffs 
If your chassis does not have board mount standoffs placed as shown, you must rearrange them so 
they match the holes in the server board.  Failure to properly rearrange the metal standoffs may 
cause the server board to malfunction and may permanently damage it.  Your chassis may be 
different from the illustration. 

OM14129
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Figure 4.  Rearrange the Standoffs 
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Install the Server Board 
To ensure proper grounding and support, it is recommended that you install screws in all the 
required mounting holes for your chassis.  You may need to move cables out of the way to properly 
install your server board. 

1. While placing the board on the chassis standoffs, carefully position the board I/O connectors 
into the rear chassis I/O openings. 

2. Adjust board position to align mounting holes with standoffs. 
3. Using the screws that came with your chassis, mount the board to the chassis. 

✏ NOTE 

If you install the server board into an Intel SR1300 or SR2300 chassis, you 
will not use all of the mounting holes.  See your chassis documentation for 
more details. 

OM14131 
Figure 5.  Installing the Server Board 
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Install the Processor Retention Brackets 
There are four brackets, two for each processor socket.  For each bracket, do the following: 

1. Place the bracket (A) on the server board. 
2. Insert and tighten two screws (B) to secure the bracket. 
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Figure 6.  Installing the Processor Retention Brackets 

Installing Processors 
1. Raise the locking bar on the socket. 

OM14132 
Figure 7.  Raising the Locking Bar  
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2. Aligning the pins of the processor with the socket, insert the processor into the socket. 

OM14133  
Figure 8.  Installing Processors 

3. Lower the locking bar completely. 

OM14135

 
Figure 9.  Lower Locking Bar 
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4. Follow the instructions packaged with your boxed processor for preparing the heat sink and 
processor for installation. 

5. Position the heat sink above the processor. 
6. Aligning the raised metal surfaces, place the heat sink on top of the processor. 

OM14134  
Figure 10.  Installing the Heat Sink 
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7. Place the heat sink clip (1) so the tab on the clip engages the slot on the heat sink (A). 
8. Press one end of the clip down (2). 
9. Press the other end of the clip down (3). 

OM14140
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Figure 11.  Installing the Heat Sink Clip 
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Memory 
Only DDR-200 or DDR-266 compliant SDRAM is supported by the server board.  Install from 
256 MB to 12 GB of registered, ECC memory, using up to six DIMMs.  A 1U chassis requires low-
profile (LP) 1.2-inch DIMMs. 

DIMMs must be installed in pairs and in the following order:  1B and 1A, 2B and 2A, 3B and 3A. 

Installed DIMMs must be the same speed and must all be registered.  For a list of supported 
memory, call your service representative or visit the Intel Support website:  

http://support.intel.com 
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Figure 12.  Installing Memory 
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Connect Cables 
Before connecting cables, consult the documentation supplied with your chassis. 
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A. External SCSI channel A connector (SCSI server board only) 
B. Internal SCSI channel B connector (SCSI server board only) 
C. Serial 1 header 
D. Combined Floppy/Front Panel/IDE connector (For use in an Intel® chassis only) 
E. Fan module connector 
F. Fan module connector 
G. Processor fan connectors (For use in a non Intel chassis only) 
H. Auxiliary power connector 
I. Main power connector 
J. Power supply signal connector 
K. Front panel connector (For use in a non Intel chassis only) 
L. Floppy connector (For use in a non Intel chassis only) 
M. IDE connector (For use in a non Intel chassis only) 
N. USB header 
O. ATA-100 primary/secondary connectors (ATA server board only) 

Figure 13.  Connecting Cables 
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Getting Started with Intel Server Management and 
Intel® SMaRT Tool (Optional) 

Intel Server Management and the hard drive Service Partition provide real-time monitoring and 
alerting for your SE7500WV2 server hardware, emergency remote management, and remote server 
setup.  Intel Server Management is implemented by installing it within client-server architecture. 

The Service Partition provides you with the ability to remotely access a local partition on the server 
and to identify and diagnose server health issues.  Remote access is provided through either a 
modem or network connection. 

To get started with Intel Server Management, install the Service Partition first, then the system’s 
operating system, and finally Intel Server Management.  The information here describes installation 
on a system running a Microsoft Windows operating system. 

The Intel Server Maintenance and Reference Training (SMaRT) Tool is an interactive software tool 
providing support information to assist with the maintenance and repair of Intel-based server 
systems and accessories.  SMaRT Tool features visual, step-by-step instructions for replacing parts; 
a complete Field Replaceable Unit (FRU) database containing part numbers and images; product 
spares lists, and worldwide Intel support information.   

Intel Server Management provides an interface to the Intel® SMaRT Tool, combining remote error 
detection and alerting with interactive maintenance and repair assistance.  When Intel Server 
Management detects a hardware error and a part needs replacing, SMaRT Tool can be launched 
directly from Intel Server Management to locate the correct part information and corresponding 
“How to Replace” steps required to quickly get the server back up and running. 

To activate Intel Server Management’s interface with the Intel SMaRT Tool, both software 
programs need to be installed.  You can install the software on a server or on a workstation used to 
manage the server.  The information here describes installation on a system running a Microsoft 
Windows operating system.  For other operating systems, see the Installation Guide & User Guide 
located in the ISM/DOCS folder on the Intel Server Management CD-ROM. SMaRT Tool and ISM 
Console may only be installed on a system running a Microsoft Windows operating system. 

✏ NOTE 

Prior to installation, uninstall any previous version of Intel Server Management. 

Installing a Service Partition on the Server (Optional) 
The Service Partition provides advanced remote management and configuration functionality.  
Installing it on a server is optional. 

1. Power-on the server, insert the Intel Server Management CD into the CD-ROM drive, and boot 
to the CD.   

2. Select Utilities > Run Service Partition Administrator > Create Service Partition-first time.   
3. Select an available hard drive.  The server will reboot to the CD.   
4. Select Format Service Partition and Install Software.  
5. Exit the menu.  Remove the CD and reboot to install the server operating system.  After 

installing the operating system, proceed to Intel Server Management Installation. 
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Installing your Operating System 
Install your operating system now. 

Installing Intel Server Management 
You can install Intel Server Management on a local server or on a remote workstation that is used 
to manage a LAN/WAN. 

1. Insert the Intel Server Management CD into the system’s CD-ROM. 
2. Click Install Server Management. 
3. Select the applicable system option. 
4. Review the Intel Software License Agreement and click Accept. 
5. If installing to a local server, click Install Now.  If this is a multiple system installation, click 

Add to compile a list of systems and then click Install Now. 
6. Select Reboot Now or Reboot Later. 
7. Remove the Intel Server Management CD. 

Installing Intel SMaRT Tool  
Follow the instructions below to install the Intel Server Maintenance and Reference Training Tool 
(SMaRT Tool) on your system. 

✏ NOTE 

SMaRT Tool may only be installed on a system running a Microsoft 
Windows operating system. 

To download the SE7500WV2 SR1300 or SE7500WV2 SR2300 server 
system module for SMaRT Tool, you must have Internet access. 

1. Insert the System Resource CD into the system’s CD-ROM drive. 
2. Click on Intel SMaRT Tool in the menu on the left side of the screen. 
3. In the green Make a Selection drop-down menu, select SMaRT Tool Install Guide.  Print the 

Guide, and keep it on hand for reference. 
4. Review the SMaRT Tool Install Guide prior to proceeding. 
5. In the Make a Selection drop-down menu, select Install SMaRT Tool. 
6. Click on the Run Installer icon to launch the SMaRT Tool Setup program. 
7. Follow the on-screen installation instructions. Review the Intel Software License Agreement 

and click Accept.  When installation is complete, launch SMaRT Tool.  
8. In SMaRT Tool’s Welcome page, click on Systems. 
9. Select Select System > Servers > Xeon > SE7500WV2 SR1300 or SE7500WV2 SR2300 and 

then follow the on-screen instructions to download the module.  When the download is 
complete, SMaRT Tool will restart. 

10. Select Systems > Select System > Servers > Xeon > SE7500WV2 SR1300 or SE7500WV2 
SR2300 to access information on your new server system. 

11. You can invoke SMaRT Tool directly from Intel Server Management’s Platform 
Instrumentation Control application by clicking on the SMaRT Tool icon, or by selecting 
Launch SMaRT Tool from the SMaRT Tool menu.  The interface between the two programs 
is context-sensitive.  To find out more about the integration between Intel SMaRT Tool and 
Intel Server Management, please select SMaRT Tool and Server Management in the Make a 
Selection drop-down menu. 
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3 Upgrading 

Tools and Supplies Needed 
• Jumper removal tool or needle nosed pliers 
• Phillips† (cross head) screwdriver (#1 bit and #2 bit) 
• Pen or pencil 
• Antistatic wrist strap and conductive foam pad (recommended) 

Cautions 
These warnings and cautions apply throughout this chapter.  Only a technically qualified person 
should configure the server board. 

 CAUTIONS 
System power on/off:  The power button DOES NOT completely turn off 
the system AC power, 5V standby is still active whenever the system is 
plugged in.  To remove power from system, you must unplug the AC power 
cord from the wall outlet.  Make sure the AC power cord is unplugged before 
you open the chassis, add, or remove any components. 

Hazardous conditions, devices & cables:  Hazardous electrical conditions 
may be present on power, telephone, and communication cables.  Turn off 
the server and disconnect the power cord, telecommunications systems, 
networks, and modems attached to the server before opening it.  Otherwise, 
personal injury or equipment damage can result.  

Electrostatic discharge (ESD) & ESD protection:  ESD can damage disk 
drives, boards, and other parts.  We recommend that you perform all 
procedures in this chapter only at an ESD workstation.  If one is not 
available, provide some ESD protection by wearing an antistatic wrist strap 
attached to chassis ground¾any unpainted metal surface¾on your server 
when handling parts. 

ESD and handling boards:  Always handle boards carefully.  They can be 
extremely sensitive to ESD.  Hold boards only by their edges.  After 
removing a board from its protective wrapper or from the server, place the 
board component side up on a grounded, static free surface.  Use a 
conductive foam pad if available but not the board wrapper.  Do not slide 
board over any surface. 

Installing or removing jumpers:  A jumper is a small plastic encased 
conductor that slips over two jumper pins.  Some jumpers have a small tab on 
top that you can grip with your fingertips or with a pair of fine needle nosed 
pliers.  If your jumpers do not have such a tab, take care when using needle  
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nosed pliers to remove or install a jumper; grip the narrow sides of the 
jumper with the pliers, never the wide sides.  Gripping the wide sides can 
damage the contacts inside the jumper, causing intermittent problems with 
the function controlled by that jumper.  Take care to grip with, but not 
squeeze, the pliers or other tool you use to remove a jumper, or you may 
bend or break the stake pins on the board. 

Memory 
The server board supports from 256 MB up to 12 GB of registered memory in six DIMM slots.  

✏ NOTES 
• Only DDR-200 or DDR-266 compliant RAM is supported by the server board. 
• A 1U chassis requires low-profile (LP) 1.2-inch (30 mm) tall DIMMs. 
• DIMMs must be populated in pairs and in the following order: 

 1B and 1A, then 2B and 2A, then 3B and 3A. 
• Installed DIMMs must be the same speed and must all be registered. 

For a list of supported memory, call your service representative or visit the Intel Customer Support 
website:   

http://support.intel.com 
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Figure 14.  Installing DIMMs 
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Processors 

 WARNING 
If the server has been running, any installed processor and heat sink on 
the processor board(s) will be hot.  To avoid the possibility of a burn, be 
careful when removing or installing server board components that are 
located near processors. 

 CAUTION 
Processor must be appropriate:  You may damage the server if you install 
a processor that is inappropriate for your server.  Make sure your server can 
handle a newer, faster processor (thermal and power considerations).  For 
exact information about processor interchangeability, contact your customer 
service representative or visit the Intel Customer Support website: 

http://support.intel.com/ 

ESD and handling processors:  Reduce the risk of electrostatic discharge 
(ESD) damage to the processor by doing the following:  (1) Touch the metal 
chassis before touching the processor or server board.  Keep part of your 
body in contact with the metal chassis to dissipate the static charge while 
handling the processor.  (2) Avoid moving around unnecessarily. 

Adding or Replacing a Processor 
If you are adding a second processor to your system, the second processor must be compatible with 
the first processor (within one stepping, same voltage, same speed, see the Intel Customer Support 
website for specifics). 

1. Observe the safety and ESD precautions at the beginning of this document. 
2. Raise the locking bar on the socket. 

OM14132 
Figure 15.  Raising the Locking Bar  
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3. Aligning the pins of the processor with the socket, insert the processor into the socket. 

OM14133  
Figure 16.  Installing Processors 

4. Lower the locking bar completely. 

OM14135

 
Figure 17.  Lower Locking Bar 

5. Follow the instructions packaged with your boxed processor for preparing the heat sink and 
processor for installation. 

6. Position the heat sink above the processor. 
7. Aligning the raised metal surfaces, place the heat sink on top of the processor. 
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OM14134  
Figure 18.  Installing the Heat Sink 

8. Place the heat sink clip (1) so the tab on the clip engages the slot on the heat sink (A). 
9. Press one end of the clip down (2). 
10. Press the other end of the clip down (3). 
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Figure 19.  Installing the Heat Sink Clip 
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Removing a Processor  
1. Observe the safety and ESD precautions at the beginning of this chapter and the additional 

cautions given here. 
2. If processor wind tunnel is installed, unplug it from the server board and remove it from the 

heat sink. 
3. Disengage the retention clip from the processor socket. 
4. Remove the processor from the socket. 

Replacing the Back up Battery 
The lithium battery on the server board powers the real time clock (RTC) in the absence of AC 
power.  When the battery starts to weaken, it loses voltage, and the server settings stored in CMOS 
RAM in the RTC (for example, the date and time) may be wrong.  Contact your customer service 
representative or dealer for a list of approved devices. 

 WARNING 
Danger of explosion if battery is incorrectly replaced.  Replace only with 
the same or equivalent type recommended by the equipment 
manufacturer.  Discard used batteries according to manufacturer’s 
instructions. 

 ADVARSEL! 
Lithiumbatteri - Eksplosionsfare ved fejlagtig håndtering.  Udskiftning 
må kun ske med batteri af samme fabrikat og type.  Levér det brugte 
batteri tilbage til leverandøren. 

 ADVARSEL 
Lithiumbatteri - Eksplosjonsfare.  Ved utskifting benyttes kun batteri 
som anbefalt av apparatfabrikanten.  Brukt batteri returneres 
apparatleverandøren. 

 VARNING 
Explosionsfara vid felaktigt batteribyte.  Använd samma batterityp eller 
en ekvivalent typ som rekommenderas av apparattillverkaren.  Kassera 
använt batteri enligt fabrikantens instruktion. 

 VAROITUS 
Paristo voi räjähtää, jos se on virheellisesti asennettu.  Vaihda paristo 
ainoastaan laitevalmistajan suosittelemaan tyyppiin.  Hävitä käytetty 
paristo valmistajan ohjeiden mukaisesti. 
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To replace the battery: 

1. Before proceeding, record your custom BIOS settings. 
2. Observe the safety and ESD precautions at the beginning of this chapter. 
3. Open the chassis and locate the battery. 
4. Push the upper end of the metal retainer away from the battery-the battery pops up. 
5. Remove the battery from its socket. 
6. Dispose of the battery according to local ordinance. 
7. Remove the new lithium battery from its package. 
8. Being careful to observe the correct polarity, lay the battery in the socket. 
9. Push the battery down-the metal retainer locks the battery in the socket. 
10. Close the chassis. 
11. Run Setup to restore the configuration settings to the RTC. 
12. Restore your custom BIOS settings. 

OM14141 
Figure 20.  Replacing the Back up Battery 
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4 Configuration Software and Utilities 

Service Partition (Optional) 
When you are setting up your server system, you can install a service partition onto your hard drive.  
The service partition includes utilities, and other software that be run locally or remotely to assist in 
system management.  The service partition uses approximately 40 MB of hard disk space.   

✏ NOTE 

It is highly recommended that you install the service partition before 
installing an operating system.  For more information, see the Service 
Partition section in the Installation Guide for Intel Server Management.  This 
document is included on the ISM CD shipped with your server board. 

Configuration Utilities 

System Software Update Sequence 
When you update the system software, you should do it in the following order. 

1. Update firmware (BMC & HSC) 
2. Update FRU/SDR 
3. Unplug system for 30 seconds 
4. Update BIOS 
5. Clear CMOS 

Table 5. Configuration Utilities 
Utility Description and brief procedure Page 

Adaptec SCSISelect† 
Utility 

Use to configure or view the settings of the SCSI host adapters and 
onboard SCSI devices in the system. 

42 

Direct Platform Control 
(DPC) Console 

Use to access and monitor the server remotely. 43 

System Setup Utility 
(SSU) and Client 
System Setup Utility 
(CSSU) 

Use for viewing and configuring server management options, viewing 
the system event log (SEL), setting boot device priority, or setting 
system security options. 

The SSU can run either from the configuration software CD or from a 
set of bootable diskettes.  You can create the diskettes from the CD. 

The CSSU is run from the service partition via the DPC console.  It 
provides the same functionality as the SSU, but from a remote console. 

Information entered via the SSU/CSSU overrides information entered 
via BIOS Setup. 

45 

continued 
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Table 5. Configuration Utilities (continued) 
Utility Description and brief procedure Page 

BIOS Update Utility Use to update the BIOS or recover from a corrupted BIOS update. 50, 56 

Firmware Update Utility Use to update BMC flash ROM or other firmware. 57 

FRU/SDR Load Utility Use to update the Field Replaceable Unit (FRU) and Sensor Data 
Record (SDR) flash components. 

NOTE:  You must run the FRU/SDR Load utility whenever the BMC is 
updated or if you change your processors. 

57 

Hot Keys 
Use the numeric pad of the keyboard to enter numbers and symbols. 

Table 6. Hot Keys 
To Do This: Press These Keys 

Secure your system immediately. <Ctrl+Alt>+hot key (Set your hot key combination with 
the SSU or BIOS Setup) 

Enter the Adaptec SCSI Utility during POST. <Ctrl+A> (SCSI version only) 

Enter the Promise Technology IDE RAID Utility. <Ctrl+F> (ATA version only) 

Enter BIOS Setup during POST. <F2> 

Abort memory test during POST. <ESC> (Press while BIOS is updating memory size on 
screen) 

Display a menu for selecting the boot device. <ESC> (Press anytime after memory check) 

To remove the splash screen. <ESC> 

Power-On Self-Test (POST) 
Each time you turn on the system the BIOS begins execution of the Power-On Self-Test (POST).  
POST discovers, configures, and tests the processors, memory, keyboard, and most installed 
peripheral devices.  The time needed to test memory depends on the amount of memory installed.  
POST is stored in flash memory. 

1. Turn on your video monitor and system.  After a few seconds, POST begins to run and displays 
a splash screen. 

2. While the splash screen is displayed: 
• Press <F2> to enter the BIOS Setup (see “BIOS Setup”) 

OR  
• Press <Esc> to view POST diagnostic messages and change the boot device priority for this 

boot only (see “Temporarily Changing the Boot Device Priority” on page 41).  
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3. After pressing <F2> or <Esc> during POST, you can press <Ctrl+A> to run the SCSISelect 
Utility.  For more information, see “Running the Adaptec SCSISelect Utility” on page42. 

4. If you do not press <F2> or <Esc> and do NOT have a device with an operating system loaded, 
the boot process continues and the system beeps once.  The following message is displayed: 
Operating System not found 

5. At this time, pressing any key causes the system to attempt a reboot.  The system searches all 
removable devices in the order defined by the boot priority. 

BIOS Setup 
You can run BIOS Setup with or without an operating system being present.  BIOS Setup stores 
most of the configuration values in battery-backed CMOS; the rest of the values are stored in flash 
memory.  The values take effect when the system is booted.  POST uses these values to configure 
the hardware.  If the values and the actual hardware do not agree, POST generates an error 
message. 

Record BIOS Setup Settings 

Record your BIOS Setup settings.  If default values ever need restoring (after a CMOS clear, for 
example), you must run BIOS Setup again.  Your record will make this much easier. 

If BIOS Setup Is Inaccessible 
If you have a misconfigured diskette drive, and you cannot use BIOS Setup to correct the problem, 
you might need to clear CMOS memory.  To clear CMOS, either of two methods can be used.  

1. Press the reset button and hold it down for four seconds or more, and then, while holding the 
reset button down, press the power button.  Release both buttons at the same time.  

2. Move the Clear CMOS jumper found on the configuration jumper block on the baseboard.  

Temporarily Changing the Boot Device Priority 
During POST, you can change the boot device priority for the current boot process.  The changes 
are not saved for the next boot process. 

1. Boot the server. 
2. At any time during POST, press <Esc>.  When POST completes, a popup Boot menu displays. 
3. Use the arrow keys to highlight the device you want the server system to boot from first.  For 

example, if you want the server system to boot from the CD-ROM first, you select “ATAPI 
CD-ROM Drive.” 

✏ NOTE 

One of the selections on the popup Boot menu is “Enter Setup.”  Selecting 
this option brings you into the BIOS Setup. 

4. Press <Enter>. 
5. The boot process continues.  When finished, a system prompt displays. 
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Running the Adaptec SCSISelect Utility 
Each host adapter includes an onboard SCSISelect configuration utility that allows you to 
configure/view the settings of the host adapter and devices in the server. 

The system finds the Adaptec AIC-7899 SCSI host adapter and displays the message Adaptec 
AIC-7899 SCSI BIOS V x.xxx where x.xxx is the version number of the SCSISelect utility.  
Pressing <Ctrl+A> at this time allows you to configure the  

Adaptec AIC-7899 SCSI host adapter. 

When to Run the Adaptec SCSISelect Utility 
Use the SCSISelect utility to: 

• Change default values 
• Check and/or change SCSI device settings that may conflict with those of other devices in the 

server 
• Do a low-level format on SCSI devices installed in the server 

Running the SCSISelect Utility 
1. When this message appears on the video monitor: 
<<<Press <Ctrl><A> for SCSISelect(TM) Utility!>>> 

2. Press <Ctrl+A> to run the utility.  When the main menu for the host adapter appears, choose 
the device that you want to configure-each SCSI bus accepts up to 15 devices.  

Use the following keys to navigate through the menus and submenus: 

Table 7. SCSISelect Navigation Keys 
Press To 

ESC Exit the utility 

Enter Select an option 

↑ Return to a previous option 

↓ Move to the next option 

F5 Switch between color and monochrome 

F6 Reset to host adapter defaults 

Configuring the Adaptec AIC-7899 SCSI Adapter 
The Adaptec AIC-7899 SCSI adapter has two busses.  Select the bus from the following menu: 

Table 8. Adaptec Main Menu 
Menu Item Options 

You have an AIC-7899 adapter in your system.  
Move the cursor to the bus:device:channel of the 
one for configuration and press <Enter>.  

Bus:Device:Channel 

01:06:A 

01:06:B 

<F5> - Toggle color/monochrome.  
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After selecting the bus, the following menu displays: 

Table 9. Menu for each SCSI Channel 
Host Adapter Option Comment 

AIC-7899 at 
Bus:Device:Channel 
01:06:A (or 01:06:B) 

Configure/View 
Host Adapter 
Settings 

Press <Enter> to view the Configuration Menu. 

 SCSI Disk Utilities Press <Enter> to view the SCSI Disk Utilities Menu.  This 
menu allows you to format hard disks and/or verify disk 
media. 

When you are finished, press <Esc> and make your selection from the following menu: 

Table 10. Exit Menu 
Feature Option Comment 

Exit Utility? Yes 
No 

When you finish configuring your SCSI devices, press <Esc>.  Then select Yes 
and press <Enter>.  When this message appears: 

Please press any key to reboot. 

Press any key, and the server reboots. 

Running the Promise FastBuild Utility 
This utility is only found on the SE7500WV2 ATA model only. 

The Promise ATA-100 host adapter is configured using the FastBuild† configuration utility that 
allows you to configure/view the settings of the host adapter and set RAID configurations. 

When to Run the Promise FastBuild Utility 
Use the FastBuild utility to: 

• Define a RAID array 
• Delete a RAID array 
• Restore a RAID array 

Running the Promise FastBuild Utility 
1. When this message appears on the video monitor: 
<<<Press <Ctrl><F> to enter FastBuild (TM) Utility>>> 

2. Press <Ctrl+F> to run the utility. 

Direct Platform Control (DPC) Console 
Direct Platform Control (DPC) Console is part of Intel Server Management.  Direct Platform 
Control is a server management application that supports remote system management via LAN, or 
an RS-232 serial connection to the server serial 2 port over a modem or a direct serial cable.  The 
Direct Platform Control Console provides the ability for remote management of Intel servers via 
modem or LAN with a capability to run DOS-based programs. 
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DPC console runs on a client workstation.  It communicates with a server by: 

• Accessing the server management capabilities of the on-board NIC 
• A Windows 2000 compatible modem. 
• An RS-232 connection to the server’s serial 2 port. 

DPC Console is independent of the server operating system.  

Even when the server is off, you can use DPC Console to verify the state of a server or diagnose a 
problem with the server hardware.  DPC console features allows you to: 

• Establish connection to remote servers  
• Server Control:  power on, power off, and reset operations 
• Retrieve and display entries in the System Event Log (SEL) 
• Retrieve and display Sensor Data Records (SDR) 
• Retrieve and display Field Replaceable Unit (FRU) information 
• Retrieve and display current Remote Sensor Access (RSA) information 
• Access a phonebook for remote connection management 
• Remote control of the service partition 
• File transfer from / to the server 

DPC Console Modes of Operation 
There are four DPC console modes of operation: 

• EMP mode.  Access the DPC console features using the DPC console window menus and/or 
toolbar.  Active when a connection is established through the EMP port. 

• DPC over LAN mode.  Access the DPC console features using the DPC console window 
menus and/or toolbar.  Active when a connection is established through the LAN. 

• Re-direct mode.  Active when the server is running BIOS console redirection.  In this mode, the 
DPC console launches a separate window.  The window operates as an ANSI terminal and 
communicates with the server through the port.  Character-based commands you type in the 
DPC Console go directly to the server, and the DPC Console displays the text that you would 
normally see on the server console.   
To use this mode, you must configure the Console Redirection option of BIOS Setup for Re-
direct mode.  Enabling Console Redirection requires that the Boot Time Diagnostics Screen be 
Enabled in BIOS Setup.  If the redirection window does not display information, the Console 
Redirection is either incorrectly configured or disabled, the EMP is disabled in BIOS Setup, or 
the server is in protected mode.  For DPC to function, the server must NOT be in graphics 
mode. 

• If the DPC console fails to connect in EMP within 10 seconds and the server can operate in Re-
direct mode, a prompt is displayed with the option to switch to Re-direct mode. 

• Service Partition mode.  Entered when the server reboots from the service partition and the 
DPC Console has successfully connected to the server through a modem.  This mode allows 
running of DOS-based programs that are stored on the service partition and transferring of files. 
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Running the DPC Console 
For more information about setting up and running the DPC Console, see the document named 
“ISM_Install_Guide.pdf.”  This document is in the ISM\DOCS directory on the ISM CD 
accompanying the SE7500WV2 server board.   

Using the System Setup Utility 
The System Setup Utility (SSU) is located on the System Resource CD-ROM shipped with the 
server. 

Run the System Setup Utility to: 

• Set boot device priority 
• Set passwords and security options 
• View system events 
• View FRU information 
• View sensor data records 
• Update system firmware and BIOS 
• Save and restore the system configuration 
• Set up the server to send alerts for platform events 
• Set up the server for remote management 

Using either the System Setup Utility or BIOS Setup, you can specify the boot device sequence and 
set up system passwords and security options.  Both utilities access the same stored configuration 
data for these items, and the result of making a change to these settings using either utility is 
identical. 

The SSU consists of a collection of task-oriented modules plugged into a common framework 
called the Application Framework (AF).  The Application Framework provides a launching point 
for individual tasks and a location for setting customization information.   

Creating SSU Diskettes 
You can run the SSU directly from the Utilities menu of the System Resource CD-ROM, from a set 
of DOS diskettes, or from the service partition of the hard disk.   

If you choose to run the SSU from a set of DOS diskettes, you must create the SSU diskettes from 
the Resource CD-ROM as follows: 

1. Boot to the System Resource CD-ROM.  
2. Choose Create Diskettes > Create Diskettes by Device/Function > System Setup Utility. 
3. Follow the instructions displayed.   

Alternatively, if you have a workstation with the Microsoft Windows operating system, you can 
insert the CD into that system and create the diskettes on that system. 
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Running the SSU 
When the SSU starts in the default local execution mode, the SSU accepts input from the keyboard 
or mouse.  The SSU presents a VGA-based GUI on the primary monitor. 

If you run the SSU from read-only media, such as the CD-ROM, you cannot save user preference 
settings (such as screen colors). 

The SSU supports ROM-DOS version 6.22.  The SSU will not operate from a “DOS box” running 
under an operating system such as Windows. 

Start the SSU using one of the following methods: 

• From diskettes:  Insert the first SSU diskette in drive A and boot the server from the diskette.  
You are prompted to insert the second diskette.  After loading completes the SSU starts 
automatically. 

• From the System Resource or ISM CD-ROM:  Boot the server to the System Resource CD and 
start the SSU from the Utilities menu. 

• From the Service Partition:  Boot the server to the Service Partition and execute the following 
DOS commands: 

C:\>  cd ssu 
C:\SSU>  ssu.bat 

The mouse driver loads if it is available; press <Enter> to continue.  

When the SSU title appears on the screen, press <Enter> to continue.  

Working with the SSU Interface 
You can access features of the SSU interface using the mouse or keyboard: 

• Mouse-Click once to choose menu items and buttons or to select items in a list, such as the 
Available Tasks list.  To run a list item, such as one of from the Available Tasks list, select the 
item and click OK or double-click the item. 

• Keyboard-Use the tab and arrow keys to highlight buttons and press the spacebar or <Enter> 
to execute.  You can also execute a menu or button by using the <Alt> key in combination with 
the underlined letter in the name of the menu or button. 

You can have more than one task open at the same time, although some tasks might require 
complete control to avoid possible conflicts.  The tasks achieve complete control by keeping the 
task as the center of operation until you close the task window. 

The SSU has a build-in help system, which you access by clicking a Help button or choosing the 
Help menu. 

Customizing the SSU Interface 
The SSU lets you customize your interface using the Preferences section of the main window.  The 
AF sets these preferences and saves them in the AF.INI file so that they take effect the next time 
you start the SSU.  There are four user customizable settings: 



Configuration Software and Utilities  47 

• Color-lets you change the default colors associated with different items on the screen using 
predefined color combinations.  The color changes take effect immediately. 

• Mode-lets you set the desired expertise level:  novice, intermediate, or expert.  The expertise 
level determines which tasks are visible in the Available Tasks section and which actions each 
task performs.  For a new mode setting to take effect, you must exit the SSU and restart it.   

• Language-lets you change the text in the SSU to the appropriate language.  For a new language 
setting to take effect, you must exit the SSU and restart it. 

• Other-lets you show or hide the status bar at the bottom of the SSU main window.  The change 
takes effect immediately. 

✏ NOTE 

If you run the SSU from read-only media (CD-ROM, for example), these 
preferences are lost when you exit the SSU. 

Exiting the SSU 
Exiting the SSU closes all SSU windows. 

Setting Boot Device Priority 
To change the boot priority of a device: 

1. From the SSU Main window, choose Boot Devices. 
2. In the Multiboot Options Add-in window, select a device. 
3. Click the Move Up button to move it up in the list.  Click the Move Down button to move it 

down. 

Setting Passwords and Security Options 
You can set a user password and an administrator password.  On some systems, you must set an 
administrator password before you can set a user password.  On other systems, the passwords are 
independent.  You can set the same passwords and security options by using BIOS Setup. 

Setting the Administrator Password 
The Admin Password button lets you set or change the administrator password used by both the 
SSU and the system BIOS.  This option is not available if both an administrator and a user 
password are set and you entered only the user password when you started the SSU.  All changes to 
the administrator password take effect immediately. 

To change or clear the administrator password: 

1. From the SSU Main window, choose Security. 
2. Click the Admin Password button. 
3. If you are changing passwords, enter the old password. 
4. Enter the new password (or leave blank to clear). 
5. Confirm the password by entering it again (or leave blank to clear). 
6. Click OK to save the password and return to the Security window. 
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Setting the User Password 
The User Password button lets you set or change the user password used by both the SSU and the 
system BIOS.  All changes to the user password take effect immediately. 

To change or clear the user password: 

1. From the SSU Main window, choose Security. 
2. Click the User Password button. 
3. If you are changing passwords, enter the old password in the first box. 
4. Enter the new password (or leave blank to clear). 
5. Confirm the password by entering it again (or leave blank to clear). 
6. Click OK to save the password and return to the Security window. 

Setting Security Options 
For a description of security features, see “Security” on page 17. 

To set the security options: 

1. In the Security window, click the Options button. 
2. For each option, select the desired setting from the list.  The options are: 

• Security Hot Key:  The key combination that can be used to put the server into secure 
mode.  

• Secure Mode Timer:  If no keyboard or mouse activity occurs during the chosen time 
interval, the server enters secure mode. 

• Secure Mode Boot:  Enable forces the server to boot directly into secure mode. 

• Video Blanking:  Enable turns off the video when the server is in secure mode. 

• Floppy Write:  Enable prevents writing to the diskette drive while the server is in secure 
mode. 

• Power Switch Inhibit:  Enable prevents the power and reset buttons from functioning 
when the server is in secure mode.  Disable allows the power and reset buttons to function 
normally when the server is in secure mode. 

3. Click Save to save the settings and return to the Security window. 

Viewing the System Event Log 
To view the System Event Log (SEL): 

1. From the SSU Main window, choose SEL Manager. 
When you start the SEL Manager, it automatically loads the current list of events from non-
volatile memory. 

2. Use the <F4> and <F5> keys to scroll the window contents to the left and right to view all of 
the columns. 
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3. Use the File and SEL menu items to work with the SEL information: 
• Open:  Views data from a previously saved SEL file. 
• Save As:  Saves the currently loaded SEL data to a file. 

• Properties:  Displays information about the SEL. 

• Clear SEL:  Clears the SEL data from the nonvolatile storage area. 

• Reload:  Refreshes the display by reading the current SEL entries from the server. 

• Sort By:  Sorts the displayed events by event number, time stamp, sensor type and number, 
event description, or event generator ID. 

Viewing FRU Information 
To view the Field Replaceable Unit (FRU) information: 

1. From the SSU Main window, choose FRU Manager. 
When you start the FRU Manager, it automatically loads the current list of events from non-
volatile memory. 
The FRU Manager window has a navigation pane on the left that displays, in a tree format, the 
inventory of components in the server.  The tree has three categories: Chassis, Board, and 
Product.  Clicking on a category expands or collapses a list of components for that category.  
Clicking on an individual component displays the FRU information for that component in the 
presentation pane in the upper right.  The description pane in the lower right displays a 
description of the currently selected FRU area. 

2. Use the <F4> and <F5> keys to scroll the window contents to the left and right to view all of 
the columns. 

3. Use the File and FRU menu items to work with the FRU information: 
• Open:  Views data from a previously saved FRU file. 
• Save As:  Saves the currently loaded FRU data to a file. 

• Properties:  Displays the number of FRU devices in the system and the number being 
displayed.  Only FRU devices with valid FRU areas are displayed. 

• Reload:  Refreshes the display by reading the current FRU entries from the server. 

Viewing Sensor Data Records 
To view the Sensor Data Records (SDR): 

1. From the SSU Main window, choose SDR Manager. 
When you start the SDR Manager, it automatically loads the SDR entries from non-volatile 
memory. 
The SDR Manager window has a navigation pane on the left that displays, in a tree format, the 
sensor data records.  The tree has categories for each type of record.  Clicking on a category 
expands or collapses a list of SDRs for that category.  Clicking on an individual SDR displays 
the information for that SDR in the presentation pane in the upper right.  The description pane 
in the lower right displays a description of the currently selected SDR type.  

2. Use the <F4> and <F5> keys to scroll the window contents to the left and right to view all of 
the columns. 
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3. Use the File and SDR menu items to work with the SDR information: 
• Open:  Views data from a previously saved SDR file. 
• Save As:  Saves the currently loaded SDR data to a file. 

• Properties:  Displays information about the SDR, including IPMI version, number of SDR 
entries, time stamps for changes to the SDR information, and free space remaining. 

• Reload:  Refreshes the display by reading the SDR data from the server. 

Updating System Firmware and BIOS 
Using the SSU, you can update the BIOS, update the firmware, and verify the firmware.  
Procedures for each are given below.  You can also update the BIOS and firmware without using 
the SSU (You can download the updates from the Intel support website:   

http://support.intel.com/support/motherboards/server 

Updating the BIOS 
To update the BIOS: 

1. Download the update from the Intel support website. 
2. From the SSU Main window, choose System Update.  (System Update is available only in 

Expert mode.) 
When you start System Update, it automatically displays the current revision information for 
the system firmware and BIOS. 

3. From the File menu, choose Load and choose a .uif or .bio file to use for the update. 
4. Click the Update button to update the BIOS. 

Updating the Firmware 
To update the system firmware: 

1. Download the update from the Intel support website. 
2. From the SSU Main window, choose System Update.  (System Update is available only in 

Expert mode.) 
When you start System Update, it automatically displays the current revision information for 
the system firmware and BIOS. 

3. From the File menu, choose Load and choose a .uif or .hex file to use for the update. 
4. Click the Update button to perform the update. 

Verifying the Firmware 
To compare the system firmware in nonvolatile memory with a firmware file: 

1. Download the update from the Intel support website. 
2. From the SSU Main window, choose System Update.  (System Update is available only in 

Expert mode.) 
When you start System Update, it automatically displays the current revision information for 
the system firmware and BIOS. 

3. From the File menu, choose Load and choose a .hex file to use for the update. 
4. Click the Verify button to compare the firmware code in nonvolatile storage with the selected 

file. 
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Saving and Restoring the System Configuration 
Using the SSU, you can save the following configuration information to a file: 

• Platform type, BIOS revision, and firmware revision 
• CMOS settings 
• Extended system configuration data (ESCD) 
• Settings for the emergency management port (EMP), platform event paging (PEP), and BMC 

LAN alerts 

Data is saved from all sources.  There is no way to choose only certain pieces of configuration data 
to save.  You can also restore the information from a saved configuration file. 

✏ NOTE 

BIOS passwords are stored in the file.  Restoring a configuration can change 
passwords on a server.  EMP and LAN passwords are not stored in the file. 

Saving a Configuration 
To save the system configuration: 

1. From the SSU Main window, choose Config Save/Restore.  (Configuration Save/Restore is 
available only in Expert mode.) 

2. Click Save To File and specify a filename and location. 

Restoring a Configuration 
To restore the system configuration from a file: 

1. From the SSU Main window, choose Config Save/Restore.  (Configuration Save/Restore is 
available only in Expert mode.) 

2. Click Restore from File and specify a filename and location. 
The CSR reads the platform type, BIOS revision, and firmware revision from the file and 
compares that information with the same information retrieved from the server.  If the two do 
not match, an error message is displayed and the restore operation aborts.  If they do match, the 
CSR restores the configuration data to the server.  It prompts you to reboot the server for the 
new settings to take effect. 

Alerting for Platform Events 
You can set up the server to alert you when various events occur.  Alerts can be delivered either as 
telephone pages or over the LAN.  Instructions for setting up both telephone paging alerts and LAN 
alerts are given below.  

Setting Up Paging Alerts 
To set up the server to send alerts as telephone pages: 

1. Install an external modem on the Emergency Management Port (serial 2). 
2. From the SSU Main window, choose Platform Event Manager (PEM). 
3. In the PEM window, click Configure EMP. 
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4. In the corresponding boxes, enter the following command strings for the modem attached to the 
EMP port (boxes that aren’t listed here are not required for paging alerts): 
• ESC Sequence:  the escape sequence.  This string is sent to the modem before sending 

command strings.  The maximum length for the string is five characters; longer strings are 
truncated. 

• Hangup String:  hang up or drop the connection.  The EMP automatically sends an 
<ENTER> character following this string.  The maximum length for the string is eight 
characters; longer strings are truncated. 

• Modem Dial Command:  the command to dial a phone number.  This string is sent to the 
modem before sending the paging string. 

• Modem Init String:  the initialization string for the modem.  This string is sent every time 
the EMP initializes.  The maximum length for the string is determined at run-time from 
firmware.  You will be notified if the string is truncated.  Following a save, the actual string 
saved is displayed in the edit box. 

5. Click Save to save the changes. 
6. Click Close to return to the PEM window. 
7. In the PEM window, click Configure PEP. 
8. Select the Enable PEP check box. 
9. In the Blackout Period box, enter the minimum time, in minutes, between successive pages.  

The valid range is [0 - 255] where 0 disables the blackout period.  Setting a blackout period can 
save you from being flooded with repeat pages.  After you receive a PEP page, no additional 
pages are sent by PEP for the duration of the blackout period. 

10. In the Paging String box, enter the phone number to dial for the page and the message you want 
sent with the page.  The maximum length for the paging string is determined at run-time from 
firmware.  You will be notified if the string is truncated.  Following a save, the actual string 
saved is displayed in the edit box. 

11. From the Options menu, choose Configure Event Actions. 
12. In the Platform Event Paging Actions window, move the events that you want to generate an 

alert to the Enabled column and move all other events to the disabled column using the 
following buttons: 

• >>:  Moves all events from the enabled list to the disabled list. 

• >:  Moves the selected event from the enabled list to the disabled list. 

• <:  Moves the selected event from the disabled list to enabled the list. 
• <<:  Moves all events from the disabled list to the enabled list. 

13. Click Save to save the changes. 
14. Click Close to return to the PEP Configuration window. 
15. To send a test page to verify that you have correctly configured PEP, from the Options menu, 

choose Send Alert. 
16. Click Save to save the configuration. 
17. Click Close to return to the Platform Event Manager window. 
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Setting Up LAN Alerts 
To set up the server to send alerts over the LAN: 

1. Configure the remote system to receive alerts.  For more information, see the documentation 
for Intel Server Management software. 

2. From the SSU Main window, choose Platform Event Manager (PEM). 
3. In the PEM window, click Configure LAN and fill in the boxes described in the following steps 

(boxes that aren’t listed here are not required for LAN alerts). 
4. Select the Enable LAN Alerts check box. 
5. (Optional) In the SNMP Community String box, enter a string for the community field in the 

Header section of the SNMP trap sent for an alert.  The string must be from 5 to 16 characters.  
The default string is public. 

6. In the IP Setup box, choose either: 
• DHCP:  the IP address for the server is automatically assigned by the DHCP (dynamic host 

control protocol) server on the network.  The Host, Gateway, and Subnet Mask boxes in the 
dialog are ignored. 

• Static:  assign the IP address for the server using the Host, Gateway, and Subnet Mask 
boxes in the dialog. 

7. If you chose Static IP Setup in the previous step, fill in the IP addressing boxes: 
• Host IP Address:  the IP address of this server. 

• Gateway IP Address:  the IP address of the router for this server. 
• Subnet Mask:  the IP address for the server’s subnet.  The server uses this to decide if the 

alert destination is on the same subnet. 
8. In the Alert IP Address box, fill in the IP address of the system you want to receive alerts from 

this server.  If you want the alert to be broadcast to an entire subnet, enter the IP address for the 
subnet. 

9. From the Options menu, choose Configure Event Actions. 
10. In the BMC LAN Alerting Actions window, move the events that you want to generate an alert 

to the Enabled column and move all other events to the disabled column using the following 
buttons: 

• >>:  Moves all events from the enabled list to the disabled list. 

• >:  Moves the selected event from the enabled list to the disabled list. 

• <:  Moves the selected event from the disabled list to enabled the list. 
• <<:  Moves all events from the disabled list to the enabled list. 

11. Click Save to save the changes. 
12. Click Close to return to the BMC LAN Configuration window. 
13. To send a test alert to verify that you have correctly configured BMC LAN alerts, from the 

Options menu, choose Send Alert. 
14. Click Save to save the changes. 
15. Click Close to return to the PEM window. 
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Managing the Server Remotely 
You can set up the server so that you can connect to it from a remote client system to perform 
management tasks.  You can make the connection over a LAN or by using a modem or direct serial 
cable to the Emergency Management Port (EMP).  Instructions for setting up the server for remote 
LAN and serial/modem access are given below. 

Setting Up Remote LAN Access 
To configure remote LAN access: 

1. From the SSU Main window, choose Platform Event Manager (PEM). 
2. In the PEM window, click Configure LAN and fill in the boxes described in the following steps 

(boxes that aren’t listed here are not required for remote access). 
3. To require a password for remote access, enter the password in the Enter New Password box 

and in the Verify New Password box.  Passwords can be from 1 to 16 characters long, using 
any ASCII character in the range [32-126].  To clear the passwords, leave both boxes blank.  
(You can also clear the password by choose the menu Options > Clear LAN Password.) 

4. From the LAN Access Mode list, select the remote access mode: 
• Full Access:  a remote system can initiate a LAN connection regardless of the state or 

health of the server. 
• Restricted:  a remote system can initiate a LAN connection, but cannot perform control 

operations such as power down, reset, or front panel NMI. 
• Disabled:  remote systems are not allowed to initiate LAN connections. 

5. In the IP Setup box, choose either: 
• DHCP:  the IP address for the server is automatically assigned by the DHCP (dynamic host 

control protocol) server on the network.  The Host, Gateway, and Subnet Mask boxes in the 
dialog are ignored. 

• Static:  assign the IP address for the server using the Host, Gateway, and Subnet Mask 
boxes in the dialog. 

6. If you chose Static IP Setup in the previous step, fill in the IP addressing boxes: 
• Host IP Address:  the IP address of this server. 

• Gateway IP Address:  the IP address of the router for this server. 

• Subnet Mask:  the IP address for the server’s subnet.  The server uses this to decide if the 
alert destination is on the same subnet. 

7. Click Save to save the changes. 
8. Click Close to return to the PEM window. 

Setting Up Remote Modem or Serial Access 
To configure remote modem or serial access: 

1. From the SSU Main window, choose Platform Event Manager (PEM). 
2. In the PEM window, click Configure EMP and fill in the boxes described in the following steps 

(boxes that aren’t listed here are not required for remote access). 
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3. To require a password for remote access, enter the password in the Enter New Password box 
and in the Verify New Password box.  Passwords can be from 1 to 16 characters long, using 
any ASCII character in the range [32-126].  To clear the passwords, leave both boxes blank.  
(You can also clear the password by choose the menu Options > Clear LAN Password.) 

4. In the Modem Ring Time box, enter the number of 500ms intervals that the BMC should wait 
before taking control of the serial 2 port and answering an incoming call.  A value greater than 
zero gives the BIOS time to answer before the BMC takes control.  A value of zero causes the 
BMC to answer immediately.  The maximum value, 63, tells the BMC to ignore the call.  
Modem Ring Time applies only to Preboot access mode and is ignored for other access modes. 

5. In the System Phone Number box, enter the number for the phone line connected to the modem 
on the EMP. 

6. From the Access Mode list, choose the remote access mode: 
• Always Active:  the EMP is available at any time. 

• Preboot:  the EMP is available only when the server is powered down or is in the running 
POST during startup. 

• Disabled:  remote systems are not allowed to initiate connections. 
7. From the Restricted Mode list, choose either: 

• Enabled:  a remote system can initiate a connection, but cannot perform control operations 
such as power down, reset, or front panel NMI. 

• Disabled:  the remote system has full control of the server. 
8. From the Connection Mode list, choose either: 

• Direct Connect:  the serial 2 port on the server is connected by a serial cable to the remote 
system. 

• Modem Connect:  the serial 2 port on the server is connected to a modem. 
9. Click Save to save the changes. 
10. Click Close to return to the PEM window. 

Software Updates 
Your system comes with preinstalled system BIOS and BMC firmware.  When necessary, updates 
will be available for download from the Intel support website at:   

http://support.intel.com/ 

Creating a Bootable Diskette 
Each update diskette created must be made bootable with ROM-DOS Ver. 6.22 or MS-DOS† 
Ver. 6.22. 

✏ NOTE 

It is recommended that the target system be booted with the Resource CD 
that accompanied the product.  However, the process for making the diskettes 
is the same for all the compatible versions of DOS.  ROM-DOS Ver. 6.22 is 
included on the Resource CD. 
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1. Insert and boot to the Resource CD. 
2. Exit from the menu to a DOS prompt. 
3. Insert a diskette into the floppy drive. 
4. At the DOS prompt, for an unformatted diskette, type: 

format a:/s 

or, for a formatted diskette, type: 
sys a: 

5. Press <Enter>. 

Software Update Package 
1. Download the software update. 
2. Print, review, and follow the instruction file (it supercedes any other instructions). 

✏ NOTE 

Be sure to record the current custom BIOS settings.  They will be cleared and 
reset to their default values during the BIOS update portion of the operation.  
You will need these settings to configure your computer at the end of the 
update procedure.  To record the current custom settings, boot the computer 
and press <F2> when you see the splash screen.  Write down the current 
custom settings in the BIOS Setup program. 

Recovering the BIOS 
It is unlikely that anything will interrupt the BIOS upgrade; however, an interruption could damage 
the BIOS.  The following steps explain how to recover the BIOS if an upgrade fails.  The following 
procedure uses recovery mode for the Setup program. 

✏ NOTE 

Because of the small amount of code available in the non-erasable boot block 
area, there is no video support.  You will not see anything on the screen 
during the procedure.  Monitor the procedure by listening to the speaker and 
looking at the floppy drive LED.   

 
1. Turn off all connected peripherals, turn off system power, and disconnect the AC power cord. 
2. Remove the access cover and expose the server board.  For instructions, see the product guide 

accompanying your chassis. 
3. Move the Recovery Boot (RCVRY BOOT) jumper from its normal position to the BIOS 

recovery position (see Figure 21 and Table 12 on page 69). 
4. Reinstall the access cover and connect the power cord. 
5. Insert the diskette holding the BIOS upgrade and recovery files into drive A.  
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6. Turn on system power and listen to the speaker:   

• Two beeps indicate successful BIOS recovery-Go to the next step. 
• A series of continuous beeps indicates failed BIOS recovery-Return to Step 1 and repeat 

the recovery process. 
7. Turn off system power and disconnect all AC power cords. 
8. Remove the access cover. 
9. Move the Recovery Boot jumper back to its normal position. 
10. Reinstall the access cover. 
11. Connect all AC power cords and turn on system power.  

Firmware Update Utility Description 
The Firmware Update Utility is a DOS-based program used to update the BMCs firmware code.  
You need to run the utility only if new firmware code is necessary. 

Running the Firmware Update Utility 
Review the release notes before proceeding. 

1. Create a DOS-bootable diskette.  The version of DOS must be 6.22 or higher. 
2. Place the firmware update utility (FWUPDATE.EXE) and the *.hex file on the diskette.  Make 

a note of the *.hex file name, because you will need it later. 
3. Insert the diskette into the drive and boot to it. 
4. At the DOS prompt, run the executable file (FWUPDATE.EXE).   
5. The utility displays a menu screen.  Select “Upload Flash.” 
6. The utility asks for a file name.  Enter the name of the *.hex file. 
7. The program will load the file and then ask if it should upload boot code.  Press “N” to 

continue unless otherwise directed by the release notes or an Intel support professional. 
8. The program next asks if it should upload operational code.  Press “Y” to continue.  The 

process of uploading operational code takes a few minutes. 
9. Once the operational code updates and verifies, press any key to continue.  Then press <ESC> 

to exit the program. 
10. Shut the system down and remove any diskettes in the system. 
11. Disconnect the AC power cord from the system and wait 30 seconds. 
12. Reconnect the AC power cord and power up the system. 

FRU/SDR Load Utility Description 
The Field Replaceable Unit (FRU) and Sensor Data Record (SDR) load utility is a DOS-based 
program used to update the server management subsystem’s product level FRU and SDR 
nonvolatile storage components (EEPROMs).  The utility: 

• Discovers the product configuration based on instructions in a master configuration file 
• Displays the FRU information 
• Updates the EEPROM associated with the Baseboard Management Controller (BMC) that 

holds the SDR and FRU area 
• Generically handles FRU devices that might not be associated with the BMC 
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What You Need to Do 
Either run the utility directly from the Resource CD or from diskettes created from the CD. 

If you run the FRU/SDR Load Utility from a diskette, copy the utility from the CD.  Follow the 
instructions in the included README.TXT file. 

If the diskette drive is disabled, or improperly configured, use BIOS Setup to enable it.  If 
necessary, disable the drive after you are done with the FRU/SDR Load Utility. 

How You Use the FRU/SDR Load Utility 
The utility: 

• Is compatible with ROM-DOS Ver. 6.22, MS-DOS Ver. 6.22 (and later versions), Windows 95 
DOS, and Windows 98 DOS 

• Accepts CFG, SDR, and FRU load files (the executable file for the utility is FRU/SDR.exe) 
• Requires the following supporting files: 

 One or more .fru files describing the system’s field replaceable units 

 A .cfg file describing the system configuration 

 An .sdr file describing the sensors in the system 

Command Line Format 

If you are not performing an automated update using a Software Update Package (SUP), the basic 
command line format is: 
FRU/SDR [-?] [-h] [-d {fru, sdr}] [-cfg filename.cfg] [-fru filename.fru] 

Table 11. Command Line Format 
Command Description 

-? or -h Displays usage information. 

-d {fru, sdr} Displays requested area only. 

-cfg filename.cfg Uses custom CFG file. 

-p Pause between blocks of data. 

Parsing the Command Line 

The FRU/SDR load utility allows only one command line function at a time.  A command line 
function can consist of two parameters.  Example:  -cfg filename.cfg.  Invalid parameters cause an 
error message and exit the program.  You can use either a slash (/) or a minus sign (-) to specify 
command line options.  Use the -p and flags with any of the other options. 

Displaying a Given Area  

When the utility is run with the -d FRU or -d SDR command line flag, information about each area 
is read from memory and printed on the screen.  Each area represents one sensor for each 
instrumented device in the server.  If the given display function fails because of an inability to parse 
the data present or a hardware failure, the utility displays an error message and exits. 
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Using Specified CFG File 

Run the utility with the command line parameter of -cfg filename.cfg.  The filename can be any 
DOS-accepted, eight-character filename string.  The utility loads the specified CFG file and uses 
the entries in that file to probe the hardware and to select the proper SDRs to load into nonvolatile 
storage.   

Displaying Utility Title and Version 

The utility displays its title: 

FRU & SDR Load Utility, Version Y.Y, Revision X.XX where Y.Y is the version number and 
X.XX is the revision number for the utility. 

Configuration File 

The configuration file is in ASCII text.  The utility executes commands formed by the strings 
present in the configuration file.  These commands cause the utility to run tasks needed to load the 
proper SDRs into the nonvolatile storage of the BMC and possibly generic FRU devices.  Some of 
the commands may be interactive and require you to make a choice. 

Prompting for Product Level FRU Information 

With a configuration file, the utility might prompt you for FRU information. 

Filtering Records from the SDR File 

The MASTER.SDR file has all the possible SDRs for the system.  You might need to filter these 
records based on the current product configuration.  The configuration file directs the filtering of 
the SDRs. 

Updating the SDR Nonvolatile Storage Area 

After the utility validates the header area of the supplied SDR file, it updates the SDR repository 
area.  Before programming, the utility clears the SDR repository area.  The utility filters all tagged 
SDRs depending on the product configuration set in the configuration file.  Untagged SDRs come 
automatically programmed.  The utility also copies all written SDRs to the SDR.TMP file; it 
contains an image of what was loaded.  The TMP file is also useful for debugging the server. 

Updating FRU Nonvolatile Storage Area 

After the configuration is determined, the utility updates the FRU nonvolatile storage area.  First, it 
verifies the common header area and checksum from the specified FRU file.  The internal use area 
reads out of the specified .FRU file then programmed into the nonvolatile storage.  The chassis area 
reads out of the specified .FRU file.  Finally, it reads the product area out of the specified FRU file, 
then the area programs into the FRU nonvolatile storage.  All areas write to the FRU.TMP file. 
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5 Solving Problems 

This chapter helps you identify and solve problems that might occur while you are using the 
system.  For additional assistance and the problem report form, refer to the SE7500WV2 Trouble 
Shooting Guide on the Support website. 

Resetting the System 
To do this: Press: 

Soft boot reset, which clears system memory and reloads the operating system. <Ctrl+Alt+Del> 

Clear system memory, restart POST, and reload the operating system. Reset button 

Cold boot reset.  Turn the system power off and then on.  This clears system memory, 
restarts POST, reloads the operating system, and halts power to all peripherals. 

Power off/on 

Initial System Startup 
Problems that occur at initial system startup are usually caused by incorrect installation or 
configuration.  Hardware failure is a less frequent cause. 

Checklist 
�� Are all cables correctly connected and secured? 
�� Are the processors fully seated in their sockets on the server board? 
�� Are all add-in PCI boards fully seated in their slots on the server board? 
�� Are all jumper settings on the server board correct? 
�� Are all jumper and switch settings on add-in boards and peripheral devices correct?  To check 

these settings, refer to the manufacturer’s documentation that comes with them.  If applicable, 
ensure that there are no conflicts-for example, two add-in boards sharing the same interrupt. 

�� Are all DIMMs installed correctly? 
�� Are all peripheral devices installed correctly? 
�� If the system has a hard disk drive, is it properly formatted or configured? 
�� Are all device drivers properly installed? 
�� Are the configuration settings made in BIOS Setup correct? 
�� Is the operating system properly loaded?  Refer to the operating system documentation. 
�� Did you press the system power on/off switch on the front panel to turn the server on (power on 

light should be lit)? 
�� Is the system power cord properly connected to the system and plugged into a  

NEMA 5-15R outlet for 100-120 V (or a NEMA 6-15R outlet for 200-240 V) 
�� Is AC power available at the wall outlet? 
�� Are all integrated components from the tested components lists? Check the tested memory, and 

chassis lists, as well as the supported hardware and operating system list on the Intel Customer 
Support website. 
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Running New Application Software 
Problems that occur when you run new application software are usually related to the software.  
Faulty equipment is much less likely, especially if other software runs correctly. 

Checklist 
�� Does the system meet the minimum hardware requirements for the software?  See the software 

documentation. 
�� Is the software an authorized copy?  If not, get one; unauthorized copies often do not work. 
�� If you are running the software from a diskette, is it a good copy? 
�� If you are running the software from a CD-ROM disk, is the disk scratched or dirty? 
�� If you are running the software from a hard disk drive, is the software correctly installed?  

Were all necessary procedures followed and files installed? 
�� Are the correct device drivers installed? 
�� Is the software correctly configured for the system? 
�� Are you using the software correctly? 

If the problems persist, contact the software vendor’s customer service representative. 

After the System Has Been Running Correctly 
Problems that occur after the system hardware and software have been running correctly often 
indicate equipment failure.  Many situations that are easy to correct, however, can also cause such 
problems. 

Checklist 
�� If you are running the software from a diskette, try a new copy of the software. 
�� If you are running the software from a CD-ROM disk, try a different disk to see if the problem 

occurs on all disks. 
�� If you are running the software from a hard disk drive, try running it from a diskette.  If the 

software runs correctly, there may be a problem with the copy on the hard disk drive.  Reinstall 
the software on the hard disk, and try running it again.  Make sure all necessary files are 
installed. 

�� If the problems are intermittent, there may be a loose cable, dirt in the keyboard (if keyboard 
input is incorrect), a marginal power supply, or other random component failures. 

�� If you suspect that a transient voltage spike, power outage, or brownout might have occurred, 
reload the software and try running it again.  (Symptoms of voltage spikes include a flickering 
video display, unexpected system reboots, and the system not responding to user commands.) 

✏ NOTE 

Random errors in data files:  If you are getting random errors in your data 
files, they may be getting corrupted by voltage spikes on your power line.  If 
you are experiencing any of the above symptoms that might indicate voltage 
spikes on the power line, you may want to install a surge suppressor between 
the power outlet and the system power cord. 
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More Problem Solving Procedures 
This section provides a more detailed approach to identifying a problem and locating its source. 

Preparing the System for Diagnostic Testing 

 CAUTION 
Turn off devices before disconnecting cables:  Before disconnecting any 
peripheral cables from the system, turn off the system and any external 
peripheral devices.  Failure to do so can cause permanent damage to the 
system and/or the peripheral devices. 

 
1. Turn off the system and all external peripheral devices.  Disconnect all of them from the 

system, except the keyboard and video monitor. 
2. Make sure the system power cord is plugged into a properly grounded AC outlet. 
3. Make sure your video display monitor and keyboard are correctly connected to the system.  

Turn on the video monitor.  Set its brightness and contrast controls to at least two thirds of their 
maximum ranges (see the documentation supplied with your video display monitor). 

4. If the operating system normally loads from the hard disk drive, make sure there is no diskette 
in drive A.  Otherwise, place a diskette containing the operating system files in drive A. 

5. Turn on the system.  If the power LED does not light, see “Power Light Does Not Light” on 
page 64. 

6. If errors are encountered, power off the system and remove all add-in cards. 

Monitoring POST 
See “Power-On Self-Test (POST)” on page40. 

Verifying Proper Operation of Key System Lights 
As POST determines the system configuration, it tests for the presence of each mass storage device 
installed in the system.  As each device is checked, its activity light should turn on briefly.  Check 
for the following: 

�� Does the diskette drive activity light turn on briefly?  If not, see “Diskette Drive Activity Light 
Does Not Light” on page 65. 

�� If a second diskette drive is installed, does its activity light turn on briefly?  If not, see 
“Diskette Drive Activity Light Does Not Light” on page 65. 

Confirming Loading of the Operating System 
Once the system boots up, the operating system prompt appears on the screen.  The prompt varies 
according to the operating system.  If the operating system prompt does not appear, see “Initial 
System Startup” on page 61. 
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Specific Problems and Corrective Actions 
This section provides possible solutions for these specific problems: 

• Power light does not light. 
• There is no beep or an incorrect beep pattern. 
• No characters appear on screen. 
• Characters on the screen appear distorted or incorrect. 
• System cooling fans do not rotate. 
• Diskette drive activity light does not light. 
• CD-ROM drive activity light does not light. 
• There are problems with application software. 
• The bootable CD-ROM is not detected. 

Try the solutions in the order given.  If you cannot correct the problem, contact your service 
representative or authorized dealer for help. 

Power Light Does Not Light 
Check the following: 

�� Is the system operating normally?  If so, the power LED is probably defective or the cable from 
the front panel to the server board is loose. 

�� Are there other problems with the system?  If so, check the items listed under “System Cooling 
Fans Do Not Rotate Properly.” 

If all items are correct and problems persist, contact your service representative or authorized dealer 
for help. 

No Characters Appear on Screen 
Check the following: 

�� Is the keyboard functioning?  Check to see that the “Num Lock” light is functioning. 
�� Is the video monitor plugged in and turned on? 
�� Are the brightness and contrast controls on the video monitor properly adjusted? 
�� Are the video monitor switch settings correct? 
�� Is the video monitor signal cable properly installed? 
�� Is the onboard video controller enabled? 

If you are using an add-in video controller board, do the following: 

1. Verify that the video controller board is fully seated in the server board connector. 
2. Reboot the system for changes to take effect. 
3. If there are still no characters on the screen after you reboot the system and POST emits a beep 

code, write down the beep code you hear.  This information is useful for your service 
representative. 

4. If you do not receive a beep code and characters do not appear, the video display monitor or 
video controller may have failed.  Contact your service representative or authorized dealer for 
help. 
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Characters Are Distorted or Incorrect 
Check the following: 

�� Are the brightness and contrast controls properly adjusted on the video monitor?  See the 
manufacturer’s documentation. 

�� Are the video monitor signal and power cables properly installed? 

If the problem persists, the video monitor may be faulty or it may be the incorrect type.  Contact 
your service representative or authorized dealer for help. 

System Cooling Fans Do Not Rotate Properly 
If the system cooling fans are not operating properly, system components could be damaged. 

Check the following: 

�� Is AC power available at the wall outlet? 
�� Is the system power cord properly connected to the system and the wall outlet? 
�� Did you press the power button? 
�� Is the power on light lit? 
�� Have any of the fan motors stopped (use the server management subsystem to check the fan 

status)? 
�� Are the fan power connectors properly connected to the server board? 
�� Is the cable from the front panel board connected to the server board? 
�� Are the power supply cables properly connected to the server board? 
�� Are there any shorted wires caused by pinched cables or power connector plugs forced into 

power connector sockets the wrong way? 

If the switches and connections are correct and AC power is available at the wall outlet, contact 
your service representative or authorized dealer for help. 

Diskette Drive Activity Light Does Not Light 
Check the following: 

�� Are the diskette drive power and signal cables properly installed? 
�� Are all relevant switches and jumpers on the diskette drive set correctly? 
�� Is the diskette drive properly configured? 
�� Is the diskette drive activity light always on?  If so, the signal cable may be plugged in 

incorrectly. 
�� If you are using the onboard diskette controller, use the Setup Utility to make sure that 

“Onboard Floppy” is set to “Enabled.”  If you are using an add-in diskette controller, make sure 
that “Onboard Floppy” is set to “Disabled.”   

If the problem persists, there may be a problem with the diskette drive, server board, or drive signal 
cable.  Contact your service representative or authorized dealer for help. 
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CD-ROM Drive Activity Light Does Not Light 
Check the following: 

�� Are the power and signal cables to the CD-ROM drive properly installed? 
�� Are all relevant switches and jumpers on the drive set correctly? 
�� Is the drive properly configured? 
�� Is the onboard IDE controller enabled? 

Problems with Application Software 
If you have problems with application software, do the following: 

�� Verify that the software is properly configured for the system.  See the software installation and 
operation documentation for instructions on setting up and using the software. 

�� Try a different copy of the software to see if the problem is with the copy you are using. 
�� Make sure all cables are installed correctly. 
�� Verify that the server board jumpers are set correctly.  See Chapter 6. 
�� If other software runs correctly on the system, contact your vendor about the failing software. 
�� If the problem persists, contact the software vendor’s customer service representative for help. 

Bootable CD-ROM Is Not Detected 
Check the following: 

�� Is the BIOS set to allow the CD-ROM to be the first bootable device? 
�� Check cable connections. 
�� Verify CD is bootable in another known good CD-ROM drive. (Especially if the CD is a copy.) 

Problems with Network 

The server hangs when the drivers are loaded: 
�� Change the PCI BIOS interrupt settings. 

Diagnostics pass, but the connection fails: 
�� Make sure the network cable is securely attached. 
�� Make sure you specify the correct frame type in your NET.CFG file. 

The Activity LED doesn’t light: 
�� Make sure the network hub has power. 

The controller stopped working when an add-in adapter was installed: 
�� Make sure the cable is connected to the port from the onboard network controller. 
�� Make sure your PCI BIOS is current. 
�� Make sure the other adapter supports shared interrupts.  Also, make sure your operating system 

supports shared interrupts. 
�� Try reseating the add in adapter. 
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The add-in adapter stopped working without apparent cause: 
�� Try reseating the adapter first; then try a different slot if necessary. 
�� The network driver files may be corrupt or deleted.  Delete and then reinstall the drivers. 
�� Run the diagnostics. 

Cannot Connect to a Server 
�� Make sure you are using the drivers that are shipped on the System Resource CD for the 

onboard network controller. 
�� Make sure the driver is loaded and the protocols are bound. 
�� Make sure the network cable is securely attached to the connector at the system back panel.  If 

the cable is attached but the problem persists, try a different cable. 
�� Make sure the hub port is configured for the same duplex mode as the network controller. 
�� Check with your LAN administrator about the correct networking software that needs to be 

installed. 
�� If you are directly connecting two servers (no hub), you will need a crossover cable (see your 

hub documentation for more information on crossover cables). 
�� Check the network controller LEDs that are visible through an opening at the system back 

panel. 
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6 Technical Reference 

Server Board Jumpers 
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Figure 21.  Jumper Locations 

Table 12. Configuration Jumper 
 Jumper Name What it does at system reset 

A RJ-45 Serial Port Config Configures either a DSR or a DCD signal to the connector.  See page 13. 

B CMOS CLR If these pins are jumpered, the CMOS settings are cleared.  These pins 
should not be jumpered for normal operation. 

C PSWD CLR If these pins are jumpered, the password is cleared.  These pins should not 
be jumpered for normal operation. 

D RCVRY BOOT If these pins are jumpered, the system will attempt BIOS recovery.  These 
pins should not be jumpered for normal operation. 

E BMC Boot Block Write 
Enable 

If these pins are jumpered, BMC boot block is erasable and programmable 
at next reset.  These pins should not be jumpered for normal operation. 
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Diagnostic LEDs 
To help diagnose POST failures, a set of four bi-color diagnostic LEDs is located on the back edge 
of the baseboard.  Each of the four LEDs can have one of four states:  Off, Green, Red, or Amber. 

The LED diagnostics feature consists of a hardware decoder and four dual color LEDs.  During 
POST, the LEDs will display all normal Port80 codes representing the progress of the BIOS POST. 
Each postcode will be represented by a combination of colors from the 4 LEDs.  The LEDs are in 
pairs of green and red.  The post codes are broken into two nibbles, an upper and a lower nibble.  
Each bit in the upper nibble is represented by a red LED and each bit in the lower nibble is 
represented by a green LED.  If both bits are set in the upper and lower nibble then both red and 
green LEDs are lit, resulting in an amber color.  Likewise, if both bits are clear then the red and 
green LEDs are off. 

During the POST process, each light sequence represents a specific Port-80 POST code.  If a 
system should hang during POST, the Diagnostic LEDs will present the last test executed before 
the hang.  When reading the lights, the LEDs should be observed from the back of the system.  The 
most significant bit (MSB) is the first LED on the left, and the least significant bit (LSB) is the last 
LED on the right.  

✏ NOTE 

When comparing a diagnostic LED color string from the baseboard to those 
listed in the diagnostic LED decoder in the following tables, the LEDs on the 
baseboard should be referenced when viewed by looking into the system 
from the back.  Reading the LEDs from left to right, the Hi bit is located on 
the left. 

Table 13. Post Codes 

Diagnostic LED Decoder 

G=Green, R=Red, A=Amber 

 

Post 
Code MSB   LSB 

 

 

Description 

07h Off G G G Uncompress various BIOS Modules. 

08h G Off Off Off Verify password Checksum. 

08h G Off Off Off Verify CMOS Checksum. 

07h Off G G G Read Microcode updates from BIOS ROM. 

07h Off G G G Initializing the processors.  Set up processor registers.  Select least 
featured processor as the BSP. 

0Bh G Off G G Hook before the keyboard BAT command is issued. 

0Ch G G Off Off Keyboard Controller Test:  The keyboard controller input buffer is 
free.  Next, issuing the BAT command to the keyboard controller. 

0Eh G G G Off Init after Keyboard Test:  The keyboard controller BAT command 
result has been verified.  Next, performing any necessary 
initialization after the keyboard controller BAT command test. 

continued 
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Table 13. Post Codes (continued) 

Diagnostic LED Decoder 

G=Green, R=Red, A=Amber 

 

Post 
Code MSB   LSB 

 

 

Description 

0Fh G G G G Write Command Byte 8042:  The initialization after the keyboard 
controller BAT command test is done.  The keyboard command 
byte will be written next. 

10h Off Off Off R Keyboard Init:  The keyboard controller command byte is written. 
Next, issuing the pin 23 and 24 blocking and unblocking 
commands. 

10h Off Off Off R Disable and initialize 8259. 

11h Off Off Off A Detect Configuration Mode, such as CMOS clear. 

13h Off Off G A Chipset Initialization before CMOS initialization. 

19h G Off Off A Init System Timer:  The 8254 timer test is over.  Starting the 
memory refresh test next. 

1Ah G Off G R Check Refresh Toggle:  The memory refresh line is toggling. 
Checking the 15 second on/off time next. 

23h Off Off A G Setup Interrupt Vectors:  Reading the 8042 input port and disabling 
the MEGAKEY Green PC feature next.  Making the BIOS code 
segment writable and performing any necessary configuration 
before initializing the interrupt vectors. 

24h Off G R Off Before Vector:  Configuration is required before interrupt vector 
initialization has completed.  Interrupt vector initialization is about 
to begin. 

25h Off G R G Init interrupt Vectors:  Interrupt vector initialization is done.  

F2h R R A R Initialize SMM handler.  Initialize USB emulation. 

F5h R A R A Validate NVRAM areas.  Restore from backup if corrupted. 

12h Off Off G R Load defaults in CMOS RAM if bad checksum or CMOS clear 
jumper is detected. 

12h Off Off G R Initializing APP CMOS RAM for appliance servers only. 

12h Off Off G R Check point After CMOS Initialized. 

27h Off G A G Validate date and time in RTC. 

F4h R A R R Load Micro Code To All CPUs. 

F6h R A A R Scan SMBIOS GPNV areas. 

15h Off G Off A 8254 Timer Test on Channel 2. 

15h Off G Off A Enable 8042. 

15h Off G Off A Keyboard Reset. 

26h Off G A Off Initialize LCD, if supported. 

28h G Off R Off Set Video Mode:  Initialization before setting the video mode is 
complete.  Configuring the monochrome mode and color mode 
settings next. 

29h G Off R G Debugger Hook. 

2Ah G Off A Off Init PCI devices and motherboard devices.  Pass control to video 
BIOS.  Start serial console redirection. 

continued 
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Table 13. Post Codes (continued) 

Diagnostic LED Decoder 

G=Green, R=Red, A=Amber 

 

Post 
Code MSB   LSB 

 

 

Description 

2Bh G Off A G Platform hook. 

2Dh G G R G Initialize AMI display manager Module.  Initialize support code for 
headless system if no video controller is detected. 

2Dh G G R G Scan flash for logos and Initialize logo data areas. 

30h Off Off R R Detect PS/2 Mouse. 

30h Off Off R R Hook after c000 ROM control. 

2Eh R R A Off Set up video parameters in BIOS data area. 

37h Off G A A Activate ADM:  The display mode is set.  Displaying the power-on 
message next. 

37h Off G A A Initialize language module.  Display splash logo. 

37h Off G A A Display Sign on message, BIOS ID and processor information. 

38h G Off R R Detect USB Mouse:  Initializing the bus input, and general devices 
next, if present. 

34h Off G R R Reset IDE Controllers. 

39h G Off R A Displaying bus initialization error messages. 

3Ah G Off A R Display Setup Message:  The new cursor position has been read 
and saved.  Displaying the Hit Setup message next. 

40h Off R Off Off Ensure Timer Keyboard Interrupts are on. 

4Bh G R G G Memory Test:  The amount of memory above 8 MB has been found 
and verified.  Checking for a soft reset and clearing the memory 
below 8 MB for the soft reset next.  If this is a power-on situation, 
going to checkpoint 4Eh next. 

57h Off A G A Chipset hook after memory size.  

53h Off R A A Display processor cache size. 

54h Off A Off R Disable parity and nmi reporting. 

60h Off R R Off Test 8237 DMA Controller:  The DMA page register test passed. 
Performing the DMA Controller 1 base register test next. 

65h Off A R G Init 8237 DMA Controller:  The DMA controller 2 base register test 
passed.  Programming DMA controllers 1 and 2 next. 

7Fh G A A A Extended NMI enable:  Extended NMI source enabling is in 
progress. 

80h R Off Off Off Enable Mouse and Keyboard:  The keyboard test has started. 
Clearing the output buffer and checking for stuck keys.  Issuing the 
keyboard reset command next. 

81h R Off Off G Keyboard Interface Test:  A keyboard reset error or stuck key was 
found.  Issuing the keyboard controller interface test command 
next. 

continued 
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Table 13. Post Codes (continued) 

Diagnostic LED Decoder 

G=Green, R=Red, A=Amber 

 

Post 
Code MSB   LSB 

 

 

Description 

82h R Off G Off Check Stuck Key Enable Keyboard:  The keyboard controller 
interface test completed.  Writing the command byte and initializing 
the circular buffer next. 

83h R Off G G Disable parity NMI:  The command byte was written and global 
data initialization has completed.  Checking for a locked key next. 

84h R G Off Off Verify RAM Size:  Checking for a memory size mismatch with 
CMOS RAM data next. 

84h R G Off Off Check ATA Cable Type presence of ATAPI devices. 

84h R G Off Off Display Keyboard Message. 

16h Off G G R Display IDE mass storage devices. 

17h Off G G A Display USB mass storage devices. 

85h R G Off G Report the first set of POST Errors To Error Manager. 

86h R G G Off Boot Password Check:  The password was checked.  Performing 
any required programming before Setup next. 

8Dh A G Off G OEM Patch 9. 

8Dh A G Off G Set Printer RS-232 Timeout. 

8Dh A G Off G Init FDD Devices:  Resetting the hard disk controller next. 

95h R G Off A Lock out PS/2 keyboard/mouse if unattended start is enabled. 

92h R Off G R Option ROM Scan. 

98h A Off Off R Init Boot Devices:  The adapter ROM had control and has now 
returned control to BIOS POST.  Performing any required 
processing after the option ROM returned control. 

9Bh A Off G A Float Processor Initialize:  Performing any required initialization 
before the coprocessor test next. 

9Eh A G G R Enable Interrupts 0,1,2:  Checking the extended keyboard, 
keyboard ID, and NUM Lock key next.  Issuing the keyboard ID 
command next. 

A2h R Off A Off Report second set of POST errors To Error messager. 

86h R G G Off Prepare And Run Setup:  Error manager displays and logs POST 
errors.  Waits for user input for certain errors.  Execute setup. 

8Bh A Off G G Set Base Expansion Memory Size. 

8Ch A G Off Off Adjust Setup:  Programming the Setup options next. 

A5h R G R G Set Display Mode. 

A7h R G A G OEM Patch 12. 

A7h R G A G Build SMBIOS table and MP tables. 

A7h R G A G Program hotkey and timeout settings in keyboard controller. 

A7h R G A G Processor initialization before boot. 

A7h R G A G Copy required language strings to shadow RAM. 

continued 



74  Intel Server Board SE7500WV2 Product Guide 

Table 13. Post Codes (continued) 

Diagnostic LED Decoder 

G=Green, R=Red, A=Amber 

 

Post 
Code MSB   LSB 

 

 

Description 

Aah A Off A Off Clear video screen. 

000h Off Off Off Off One Beep to indicate end of POST.  No beep if silent boot is 
enabled. 

000h Off Off Off Off POST completed.  Passing control to INT 19h boot loader next. 

POST Error Codes and Messages 
The following table defines POST error codes and their associated messages.  The BIOS prompts 
the user to press a key in case of serious errors.  Some error messages are preceded by the word 
"Error" to highlight the fact that the system might be malfunctioning.  All POST errors and 
warnings are logged in the System Event Log, unless the System Event Log is full. 

Table 14. Standard POST Error Messages and Codes 
Error Code Error Message Pause on Boot 

100 Timer Channel 2 Error Yes 

101 Master Interrupt Controller Yes 

102 Slave Interrupt Controller Yes 

103 CMOS Battery Failure Yes 

104 CMOS Options not Set Yes 

105 CMOS Checksum Failure Yes 

106 CMOS Display Error Yes 

107 Insert Key Pressed Yes 

108 Keyboard Locked Message Yes 

109 Keyboard Stuck Key Yes 

10A Keyboard Interface Error Yes 

10B System Memory Size Error Yes 

10E External Cache Failure Yes 

110 Floppy Controller Error Yes 

111 Floppy A: Error Yes 

112 Floppy B: Error Yes 

113 Hard disk 0 Error Yes 

114 Hard disk 1 Error Yes 

115 Hard disk 2 Error Yes 

116 Hard disk 3 Error Yes 

117 CD-ROM disk 0 Error Yes 

118 CD-ROM disk 1 Error Yes 

continued 
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Table 14. Standard POST Error Messages and Codes (continued) 

Error Code Error Message Pause on Boot 

119 CD-ROM disk 2 Error Yes 

11A CD-ROM disk 3 error Yes 

11B Date/Time not set Yes 

11E Cache memory bad Yes 

120 CMOS clear Yes 

121 Password clear Yes 

140 PCI Error Yes 

141 PCI Memory Allocation Error Yes 

142 PCI IO Allocation Error Yes 

143 PCI IRQ Allocation Error Yes 

144 Shadow of PCI ROM Failed Yes 

145 PCI ROM not found Yes 

146 Insufficient Memory to Shadow PCI ROM Yes 
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Table 15. Extended POST Error Messages and Codes 
Error Code Error Message Pause on Boot 

8100 Processor 1 failed BIST No 

8101 Processor 2 failed BIST No 

8110 Processor 1 Internal error (IERR) No 

8111 Processor 2 Internal error (IERR) No 

8120 Processor 1 Thermal Trip error No 

8121 Processor 2 Thermal Trip error No 

8130 Processor 1 disabled No 

8131 Processor 2 disabled No 

8140 Processor 1 failed FRB-3 timer No 

8141 Processor 2 failed FRB-3 timer No 

8150 Processor 1 failed initialization on last boot. No 

8151 Processor 2 failed initialization on last boot. No 

8160 Processor 01: unable to apply BIOS update Yes 

8161 Processor 02: unable to apply BIOS update Yes 

8170 Processor P1 :L2 cache Failed Yes 

8171 Processor P2 :L2 cache Failed Yes 

8180 BIOS does not support current stepping for Processor P1 Yes 

8181 BIOS does not support current stepping for Processor P2 Yes 

8190 Watchdog Timer failed on last boot No 

8191 4:1 Core to bus ratio: Processor Cache disabled Yes 

8192 L2 Cache size mismatch Yes 

8193 CPUID, Processor Stepping are different Yes 

8194 CPUID, Processor Family are different Yes 

8195 Front Side Bus Speed mismatch. System Halted Yes, Halt 

8196 Processor Model are different Yes 

8197 CPU Speed mismatch Yes 

8300 Baseboard Management Controller failed to function Yes 

8301 Front Panel Controller failed to Function Yes 

8305 Hotswap Controller failed to Function Yes 

8420 Intelligent System Monitoring Chassis Opened Yes 

84F1 Intelligent System Monitoring Forced Shutdown Yes 

84F2 Server Management Interface Failed Yes 

84F3 BMC in Update Mode Yes 

84F4 Sensor Data Record Empty Yes 

84FF System Event Log Full Yes 
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BIOS Recovery Beep Codes 
In the case of a Bootblock update, where video is not available for text messages to be displayed, 
speaker beeps are necessary to inform the user of any errors.  The following table describes the type 
of error beep codes that may occur during the Bootblock update. 

Table 16. BIOS Recovery Beep Codes 
Beeps Error message POST Progress Code Description 

1 Recovery started  Start recovery process. 

2 Recovery boot error Flashing series of 
POST codes:  
E9h 
EEh 
EBh 
ECh 
EFh 

Unable to boot to floppy, ATAPI, 
or ATAPI CD-ROM. Recovery 
process will retry. 

Series of long  
low-pitched single 
beeps 

Recovery failed EEh Unable to process valid BIOS 
recovery images. BIOS already 
passed control to operating 
system and flash utility. 

2 long high-pitched 
beeps 

Recovery complete EFh BIOS recovery succeeded, ready 
for power-down, reboot. 

Bootblock Error Beep Codes 
Table 17. Bootblock Error Beep Codes 

Beeps Error message Description 

1 Refresh timer failure The memory refresh circuitry on the motherboard is faulty. 

2 Parity error Parity can not be reset. 

3 Base memory failure Base memory test failure. **See "3-Beep-Boot Block 
Failure Error Code" table for additional error details. 

4 System timer System timer is not operational. 

5 Processor failure Processor failure detected.. 

6 Keyboard controller Gate A20 failure The keyboard controller may be bad. The BIOS cannot 
switch to protected mode. 

7 Processor exception interrupt error The CPU generated an exception interrupt. 

8 Display memory read/write error The system video adapter is either missing or its memory 
is faulty. This is not a fatal error. 

9 ROM checksum error System BIOS ROM checksum error. 

10 Shutdown register error Shutdown CMOS register read/write error detected. 

11 Invalid BIOS General BIOS ROM error. 
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7 Regulatory and Integration Information 

Product Regulatory Compliance 

Product Safety Compliance 
The SE7500WV2 complies with the following safety requirements: 

• UL 1950 - CSA 950 (US/Canada) 
• EN 60 950 (European Union) 
• IEC60 950 (International) 
• CE - Low Voltage Directive (73/23/EEC) (European Union) 
• EMKO-TSE (74-SEC) 207/94 (Nordics) 
• GOST R 50377-92 (Russia) 

Product EMC Compliance  
The SE7500WV2 has been has been tested and verified to comply with the following 
electromagnetic compatibility (EMC) regulations when installed in a compatible Intel® host system.  
For information on compatible host system(s), contact your local Intel representative. 

• FCC (Class A Verification) - Radiated & Conducted Emissions (USA) 
• ICES-003 (Class A) - Radiated & Conducted Emissions (Canada) 
• CISPR 22 (Class A) - Radiated & Conducted Emissions (International)  
• EN55022 (Class A) - Radiated & Conducted Emissions (European Union) 
• EN55024 (Immunity) (European Union) 
• CE - EMC Directive (89/336/EEC) (European Union) 
• GOST R 29216-91 Radiated & Conducted Emissions (Russia) 
• GOST R 50628-95 Immunity (Russia) 
• VCCI (Class A) - Radiated & Conducted Emissions (Japan) 
• AS/NZS 3548 (Class A) - Radiated & Conducted Emissions (Australia / New Zealand) 
• RRL (Class A) Radiated & Conducted Emissions (Korea) 
• BSMI (Class A) Radiated & Conducted Emissions (Taiwan) 
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Product Regulatory Compliance Markings 
This product is marked with the following Product Certification Markings: 

• UL Recognition Mark   

• CE Mark    

• Russian GOST Mark   

• Australian C-Tick Mark  

• BSMI Certification Number  

• BSMI EMC Warning   

• Korean RRL MIC Mark  
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Electromagnetic Compatibility Notices 

FCC (USA) 
This device complies with Part 15 of the FCC Rules.  Operation is subject to the following two 
conditions:  (1) this device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired operation. 

For questions related to the EMC performance of this product, contact: 

 Intel Corporation 

 5200 N.E. Elam Young Parkway 

 Hillsboro, OR 97124 

 1-800-628-8686 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection 
against harmful interference in a residential installation.  This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications.  However, there is no guarantee that 
interference will not occur in a particular installation.  If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or more of the following 
measures: 

• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and the receiver. 
• Connect the equipment to an outlet on a circuit other than the one to which the receiver is 

connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Any changes or modifications not expressly approved by the grantee of this device could void the 
user’s authority to operate the equipment.  The customer is responsible for ensuring compliance of 
the modified product. 

Only peripherals (computer input/output devices, terminals, printers, etc.) that comply with FCC 
Class A or B limits may be attached to this computer product.  Operation with noncompliant 
peripherals is likely to result in interference to radio and TV reception. 

All cables used to connect to peripherals must be shielded and grounded.  Operation with cables, 
connected to peripherals, that are not shielded and grounded may result in interference to radio and 
TV reception. 

INDUSTRY CANADA (ICES-003) 
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital 
apparatus set out in the interference-causing equipment standard entitled: “Digital Apparatus,” 
ICES-003 of the Canadian Department of Communications. 
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Cet appareil numérique respecte les limites bruits radioélectriques applicables aux appareils 
numériques de Classe A prescrites dans la norme sur le matériel brouilleur: « Appareils 
Numériques », NMB-003 édictée par le Ministre Canadien des Communications. 

Europe (CE Declaration of Conformity) 
This product has been tested in accordance too, and complies with the Low Voltage Directive 
(73/23/EEC) and EMC Directive (89/336/EEC).  The product has been marked with the CE Mark 
to illustrate its compliance.  

Australian Communications Authority (ACA) 
(C-Tick Declaration of Conformity) 

This product has been tested to AS/NZS 3548, and complies with ACA emission requirements.  
The product has been marked with the C-Tick Mark to illustrate its compliance.  

Ministry of Economic Development (New Zealand) Declaration of 
Conformity 

This product has been tested to AS/NZS 3548, and complies with New Zealand’s Ministry of 
Economic Development emission requirements. 

BSMI (Taiwan) 
The BSMI DOC Mark is silk screened on the component side of the server board; and the BSMI 
EMC warning is located on solder side of the server board.  
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8 Equipment Log and Power Consumption 
Worksheets 

Equipment Log 
Use the blank equipment log provided here to record information about your system.  You will 
need some of this information when you run the SSU. 

 
Item 

Manufacturer Name and 
Model Number 

 
Serial Number 

 
Date Installed 

System 
 

   

Server Board 
 

   

Primary Processor 
Speed and Cache 

   

Secondary Processor 
Speed and Cache 

   

Video Display 
 

   

Keyboard 
 

   

Mouse 
 

   

Diskette Drive A 
 

   

Diskette Drive B 
 

   

Tape Drive 
 

   

CD-ROM Drive 
 

   

Hard Disk Drive 1 
 

   

Hard Disk Drive 2 
 

   

Hard Disk Drive 3 
 

   

Hard Disk Drive 4 
 

   

Hard Disk Drive 5 
 

   

continued 
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Equipment Log (continued) 
 

 
Item 

Manufacturer Name and 
Model Number 

 
Serial Number 

 
Date Installed 
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Current Usage 

✏ NOTE 

Both processors pull power from +12V.  This may limit the number of drives 
and/or add-in cards you may install. 

The average power usage should not exceed 15 watts per PCI slot. 

The cooling efficiency varies per slot; therefore, ensure that adequate cooling is available in the 
target slot-especially in an expansion slot dissipating more than 10 Watts. 

Calculating Power Consumption 
The total combined wattage for the system configuration must be less than the output of your power 
supply.  Use the two worksheets in this section to calculate the power used by your server boards.  
For current and voltage requirements of add-in boards and peripherals, see your vendor documents. 

Worksheet, Calculating DC Power Usage 
1. List the current for each board and device in the appropriate voltage level column. 
2. Add the currents in each column.  Then go to the next worksheet. 

Table 18. Power Usage Worksheet 1 
 Current (maximum) at voltage level: 

Device +3.3 V 3.3 V Standby +5 V 5 V Standby +12 V -12 V 

Server board 6.6 A 0.0 A 2.6 A 1.5 A .5 A 0.0 A 

Primary Processor        

Secondary Processor        

Memory (six DIMMs)       

Full-Height PCI riser slot 
(see note 1) 

      

     PCI slot 1       

     PCI slot 2       

     PCI slot 3       

Low-Profile PCI riser slot 
(see note 1) 

      

     PCI slot 1       

     PCI slot 2       

     PCI slot 3       

Server Board Current 
SUBTOTALS 

      

       

System Components  
(see note 2) 

      

       

Total Current       

Note 1:  Number of PCI cards depends on system and riser card configuration. 
Note 2:  List additional system devices and associated currents. 
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Worksheet, Total Combined Power Used by the System 
1. From the previous worksheet, enter the total current for each column. 
2. Multiply the voltage by the total current to get the total wattage for each voltage level. 
3. Add the total wattage for each voltage level to arrive at a total combined power usage on the 

power supply. 

Table 19. Power Usage Worksheet 2 
Voltage level and total current 
(V X A = W) 

Total Watts 
for each voltage level 

(+3.3 V) X (______ A) ________ W 

(+5 V) X (______ A) ________ W 

(-5 V) X (______ A) ________ W 

(+12 V) X (______ A) ________ W 

(-12 V) X (______ A) ________ W 

Total Combined Wattage ________ W 
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Index 

A 
ACPI, 14 

Alerting, 16, 53, 55 

B 
Baseboard Management Controller, 14, 15, 16, 

41, 42, 53, 55, 57, 59, 71 

Battery, 38 

BIOS, 41, 42 
recovery, 71 

BIOS Setup, 17 
BMC. See Baseboard Management Controller 

Boot sequence, 20, 42, 43, 49, 50 

C-D 
CMOS, 38, 41, 43, 53, 71 

Console Redirection, 46 

Direct Platform Control, 16, 41, 45, 46, 47 
DPC. See Direct Platform Control 

E 
Emergency Management Port, 14, 16, 46, 53, 

54, 56, 57 
EMP. See Emergency Management Port 

ESD, 33, 35, 38 

F 
Field Replaceable Unit, 14, 15, 31, 41, 42, 46, 

47, 51, 59, 60, 61 

Firmware, 52 

Firmware Update Utility, 42, 59 
FRU. See Field Repalceable Unit 

FRU/SDR Load Utility, 14, 15, 42, 59, 60 

H-I 
Hot Keys, 42 

Intel Server Management, 14, 16, 17, 31, 32, 
41, 45, 48, 55 

ISM. See Intel Server Management 

J-N 
Jumpers, 13, 71 

Memory, 7, 10, 29, 34 

Network, 7, 12, 16, 32, 45, 46, 53, 55, 56,  
57, 68 

P 
Passwords, 17, 19, 20, 49, 50, 56, 57 

Platform Event Management, 15 

Platform Event Paging, 16 

POST, 20, 42, 43, 65, 66, 72 

Processors, 7, 10, 25, 35, 38 

R 
Remote Access, 31, 56 

RJ-45 Serial Port, 12, 16, 71 

S 
SDR. See Sensor Data Record 

Secure mode, 18, 19 

Security, 17, 19, 20, 49, 50 
SEL. See System event log 

Sensor Data Record, 14, 15, 41, 42, 46, 51, 52, 
59, 60, 61 

Serial Over LAN, 16 

Server Board Version 
ATA, 7, 11, 42 
SCSI, 7, 11, 42 

Server configuration wizard, 16 

Service Partition, 31 

SMaRT Tool, 31, 32 
SSU. See System Setup Utility 

System event log, 14, 15, 41, 46, 50, 51 

System Setup Utility, 12, 14, 15, 16, 17, 18,  
19, 20, 41, 42, 47, 48, 49, 50, 51, 52, 53, 55, 
56, 85 
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